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Preface

About This Guide

This guide describes how to issue and manage end-user certificates in 
RSA Registration Manager. It is intended for Vettors and other trusted personnel. Do 
not make this guide available to the general user population.

RSA Registration Manager Documentation

For more information about Registration Manager, see the following documentation:

Readme. Provides information about what is new and changed in this release, as 
well as workarounds for known issues. The latest version of the Readme is 
available from RSA SecurCare Online: https://knowledge.rsasecurity.com.

Installation Guide. Describes detailed procedures on how to install and initially 
configure RSA Registration Manager.

Administrator’s Guide. Describes the operation and administration of 
RSA Registration Manager.

Vettor’s Guide. Provides information for your Vettors about how to issue 
certificates and manage certificate status in RSA Registration Manager.

RSA Registration Manager Help. Describes day-to-day administration tasks 
performed through the administrative interface. To view the Help, click Help in 
the administrative interface.

Related Documentation

For more information about products related to Registration Manager, see the 
following:

RSA Certificate Manager documentation set. The full documentation set for 
RSA Certificate Manager is included in the \Documentation directory of the 
RSA Certificate Manager CD.

RSA Solutions Gallery. RSA has worked with a number of manufacturers to 
qualify products that work with RSA products. Qualified third-party products 
include virtual private network (VPN) and remote access servers (RAS), routers, 
web servers, and many more. To access the directory, including implementation 
guides and other information, go to www.securedbyrsa.com.
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Getting Support and Service

RSA SecurCare Online offers a knowledgebase that contains answers to common 
questions and solutions to known problems. It also offers information on new releases, 
important technical news, and software downloads.

The RSA Solutions Gallery provides information about third-party hardware and 
software products that the Secured by RSA Certified Partner Program has certified to 
work with RSA products. The directory includes Implementation Guides with 
step-by-step instructions and other information about interoperation of RSA products 
with these third-party products.

Before You Call Customer Support

Make sure you have direct access to the computer running the RSA Registration 
Manager software.

Please have the following information available when you call:

 Your RSA Customer/License ID. You can find this number on the license 
certificate that shipped with the product or on the label of the license CD, as 
applicable.

 RSA Registration Manager software version and build number. 

 The make and model of the machine on which the problem occurs.

 The name and version of the operating system under which the problem occurs.

RSA SecurCare Online https://knowledge.rsasecurity.com

Customer Support Information www.rsa.com/support

RSA Solutions Gallery www.securedbyrsa.com
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Part 1. Introduction

Part 1 provides introductory information about RSA® Registration Manager, the roles 
and responsibilities of the people working with Registration Manager, and the 
components of Registration Manager. It also provides information on obtaining a 
Vettor certificate, a digital certificate that you must install in your browser before you 
can perform Vettor tasks.

Part 1 consists of the following chapters:

• Chapter 1, “Overview of RSA Registration Manager”

• Chapter 2, “Roles and Responsibilities”

• Chapter 3, “Overview of the RSA Registration Manager Web Interface”

• Chapter 4, “Obtaining a Vettor Certificate”
Introduction 9
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1 Overview of RSA Registration Manager

This chapter provides an overview of RSA Registration Manager. Registration 
Manager is a registration authority (RA) software application. It provides registration 
and management services on behalf of a certificate authority (CA).

This chapter describes the following concepts:

• What Is RSA Registration Manager

• Why Use RSA Registration Manager

• What Is an RSA Registration Manager Installation

• RSA Registration Manager and Jurisdictions

What Is RSA Registration Manager

Registration Manager provides an RA that works with RSA Certificate Manager to 
easily provide certificates to large numbers of end users. Registration Manager 
receives certificate requests, verifies the identity of the end-entities, and approves 
requests. Certificate Manager then issues certificates.

Registration Manager simultaneously supports public key infrastructure (PKI) 
applications over multiple protocol interfaces: LDAP, SSL-LDAP, HTTP, HTTPS, and 
SCEP. Registration Manager interoperates with other PKI-aware products.

Registration Manager runs on Windows, Solaris, and Linux servers. It includes a 
secure Web Server for web-based administration and enrollment. It also includes a 
secure Lightweight Directory Access Protocol (LDAP) directory, known alternatively 
as the Secure Directory Server. 

Registration Manager is administered securely. Most administration is completed 
using the administration interface of the Web Server. The Registration Manager 
architecture supports secure web-based administration using client-authenticated and 
server-authenticated SSL sessions. It can be managed by multiple Administrators, 
each with ownership of an individual portion of Registration Manager operations. 
Administrators are identified with certificates, which must be presented to the Web 
Server prior to performing administrative functions. 
1: Overview of RSA Registration Manager 11
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Why Use RSA Registration Manager

Registration Manager can increase the security, productivity, and flexibility of your 
PKI.

Security

Registration Manager can operate on the public side of a firewall while Certificate 
Manager is secured behind the firewall (for example, if your business requires that 
Registration Manager server be accessible to end-entities outside the domain of 
Certificate Manager).

Productivity

You can:

• Reduce registration traffic to Certificate Manager, thus improving the efficiency, 
productivity, and responsiveness of Certificate Manager

• Distribute work to multiple Registration Manager Administrators and Vettors

• Accept certificate requests even if Certificate Manager is down

• Leverage your company’s existing information repositories to be used by 
Registration Manager

Flexibility

You can:

• Implement local enrollment centers at multiple geographic locations

• Implement manual procedures, as may be required for a high-security 
environment, or automatic procedures (autovetting), as when processing requests 
from known members within a large enterprise

• Accommodate company growth by utilizing the scalability of Registration 
Manager. As the flow of requests increases, you can add Registration Managers to 
accommodate the workload so no one Registration Manager is overwhelmed

What Is an RSA Registration Manager Installation

An installation of Registration Manager is a collection of servers that together allow 
end users to enroll for certificates and Vettors to manage the certificates issued by 
Certificate Manager. Registration Manager is a tool to assist with enrollment of a large 
number of users into a PKI.
12 1: Overview of RSA Registration Manager
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RSA Registration Manager and Jurisdictions

A Jurisdiction is a set of configurations that define the form and content of the 
certificates issued under it, the life cycle management of those certificates, and the 
look and feel that end users find when enrolling. Jurisdictions are created at the 
Certificate Manager installation, not at the Registration Manager installation.

A Certificate Manager installation can have multiple CAs and each CA can have 
multiple Jurisdictions. When Registration Manager is installed, it is targeted to one 
Jurisdiction. That Jurisdiction is called the initial target Jurisdiction. By default, 
Registration Manager manages certificates for the initial target Jurisdiction.

After installation, you can add additional target Jurisdictions for which Registration 
Manager performs registration and management services. A target Jurisdiction may 
have multiple Registration Managers associated with it. You can remove access to 
target Jurisdictions added after installation but you cannot remove access to the initial 
target Jurisdiction.

In the following illustration, Registration Manager was installed against a target 
Jurisdiction, Jurisdiction A. Registration Manager is later given permission to manage 
certificates for Jurisdiction Y.
1: Overview of RSA Registration Manager 13
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2 Roles and Responsibilities

This chapter describes the roles and responsibilities of the different user groups that 
install or use RSA Registration Manager. Users fall into two main groups:

• Administrative users—Administrators, Vettors, and Auditors

• End users

An administrative user to assume more than one administrative role. For example, a 
person responsible for performing Administrator tasks may perform Vettor and 
Auditor tasks as well. By default, an Administrator certificate request has all three 
roles selected. By default, a Vettor or Auditor certificate request has only that role 
selected.

All users are responsible for following the security practices established by their 
organization. One of the most important security practices is protecting the private key 
associated with the certificate. 

Note: All Vettors should read “Protecting Your Private Key” on page 33.

Administrator Role

Registration Manager supports an unlimited number of Administrators. Multiple 
Administrators serve as a backup in case of absence or workload concerns. 
Administrator tasks may include planning the PKI implementation, installing or 
upgrading Registration Manager, performing initial configuration, and managing the 
daily administration tasks.

Vettor Role

Registration Manager supports an unlimited number of Vettors. Vettors are the trusted 
individuals within an organization that review requests for end-entity certificates. 
Vettors determine whether the CA should issue a certificate. Vettors also manage the 
status of certificates after they are issued. The Vettor is the only administrative role 
allowed to perform these tasks.

In determining whether a certificate should be issued, Vettors should adhere strictly to 
their organization’s security policy. Usually, this is established in a Certification 
Practice Statement (CPS). 

To assume vetting responsibilities, the Vettor must request and obtain a Vettor 
certificate. For more information, see Chapter 4, “Obtaining a Vettor Certificate.”
2: Roles and Responsibilities 15
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Reviewing Certificate Requests

Vettors perform the following tasks to determine whether a certificate request should 
be approved:

• Examine the information entered on the request form

• Verify the identity of the end user

• Modify or correct information entered on the request form, if allowed by the target 
Jurisdiction

• Select certificate extensions and values for configurable certificates

Vetting Certificate Requests

After reviewing the information in a certificate request against the authorization and 
validation criteria established in their PKI, Vettors perform one of the following tasks:

• Defer a certificate request (put a questionable certificate request in an “on hold” 
queue for attention at a later time)

• Refuse a certificate request (mark the request as “refused,” in which case no 
certificate is issued)

• Delete a certificate request (remove the request from the queue, although this 
procedure is rarely used)

• Approve a certificate request (send the request to the target Jurisdiction to be 
issued, that is, signed and returned)

For more information, see Chapter 5, “Vetting Certificate Requests.”

Managing Certificates

In addition to processing initial requests, Vettors also manage the status of certificates 
after they are issued. Vettors perform the following tasks to manage certificate status:

• Check the status of a certificate (for example, to see if the certificate is about to 
expire and needs to be reissued)

• Revoke a certificate (for example, if a certificate owner leaves the company, 
changes departments, or reports that the private key has been compromised)

• Reissue a certificate (for example, if a certificate is about to expire or has been 
deleted in error)

• Suspend a certificate (for example, if a customer has an overdue account and 
certificate privileges need to be temporarily removed)

• Reinstate a suspended certificate (for example, if a customer with a suspended 
certificate has paid an overdue account)

For more information, see Chapter 6, “Managing Certificates.”
16 2: Roles and Responsibilities



RSA Registration Manager 6.9 Vettor’s Guide
Auditor Role

Auditors are the trusted individuals within an organization that manage the audit logs 
generated by the Secure Logging Server. Registration Manager supports an unlimited 
number of Auditors. The Auditor is the only administrative role allowed to perform 
these tasks.

End User Role

An end user is an individual, group, or organization that either requests or holds an 
end-entity certificate. An end user can also be an individual who requests an 
end-entity certificate for a hardware device (such as a router), a server, a software 
application, or even a piece of code.

An end user that requests a certificate is sometimes called a requestor. An end user 
that is issued a certificate is sometimes called a certificate owner, certificate subject, 
or end-entity. An end user that relies upon someone else’s certificate to verify that 
other person’s identity is also sometimes called an end user, certificate user, or relying 
party.

Like administrative users, end users are responsible for following the security 
practices dictated by their organization. Failure to do so can compromise their 
organization’s entire system for securing its electronic communications and 
transactions. For more information, see “Protecting Your Private Key” on page 79, 
and Chapter 10, “Trusting the Certificates of Others.”

End users can perform the following tasks (if they have the appropriate software): 

• Obtain an end-user certificate and install it, along with the certificate of the CA 
that issued the certificate

• Manage the certificate throughout its life cycle

• Use the public key in another person’s certificate to encrypt data or messages so 
that only that person can read it

• Use the private key associated with their own certificate to decrypt encrypted data 
or messages received from others

• Use the private key associated with their own certificate to sign data or messages

• Use their own certificate to prove their identity to servers

• Use another entity’s certificate to verify that entity’s identity

Obtaining an End-User Certificate

End users can perform the following tasks to obtain a certificate: 

• Enroll for a certificate

• Download and/or install the certificate

• Save the certificate to a file and export it to other applications

• Download the certificate of the certificate authority that issued their certificate

For more information on these tasks, see Chapter 8, “Obtaining a Certificate.”
2: Roles and Responsibilities 17
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Managing the Certificate

End users can perform any of the following tasks to manage their certificate 
throughout its life cycle:

• Revoke the certificate (for example, if they suspect that the private key has been 
compromised)

• Request that the certificate be reissued (for example, if they revoke the certificate 
by mistake)

• Renew the certificate, if renewal is permitted (usually, just before it expires)

For more information, see Chapter 9, “Managing a Digital Certificate.”

Using Keys and Certificates

Depending on the software application they are using, end users can use their own and 
others’ keys to encrypt and decrypt data, sign data, prove their own identity, and verify 
the identity of others.

Using Another’s Public Key to Encrypt Data

End users can use others’ certificates to encrypt data and messages sent to others. The 
procedures for encrypting and decrypting data and messages vary according to the 
application being used.

Using a Private Key to Decrypt Data

End-user applications that are PKI-enabled automatically locate the private key 
associated with the end user’s certificate and perform the necessary computations to 
decrypt encrypted data that has been sent to the end user. No action is required by the 
end user.

Using a Private Key to Sign Data

End users can use the private key associated with their certificate to sign data or 
messages. The procedure for doing so varies according to the application being used.

Using a Certificate to Prove Identity

End users can use their certificates to prove their identity to servers that require client 
authentication. If they have multiple certificates, they must select the appropriate 
certificate for each server.

Verifying the Identity of Others

End users can perform the following tasks to verify the status of other certificates 
(whether they be individuals, web servers, software code, or hardware devices):

• Specify to their browser (or other application) whether to trust the certificate 
authority that issued the certificate

• Download revocation lists (complete CRLs, delta CRLs, and ARLs)

• Download the certificate of the revocation list signer

For more information, see Chapter 10, “Trusting the Certificates of Others.”
18 2: Roles and Responsibilities
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3 Overview of the RSA Registration Manager
Web Interface

This chapter describes the Administrative and Enrollment interfaces of 
RSA Registration Manager. Administrators, Vettors, Auditors, and end users each use 
different parts of the interfaces. This chapter also describes the browser settings you 
must enable to display Registration Manager pages properly.

Important: Use the Back button in the Registration Manager graphical user interface 
(GUI). Using the browser Back button may produce unexpected results.

Browser Settings

Important: If you use Internet Explorer on a Windows 2003 platform and the Internet 
Explorer Enhanced Security Configuration is enabled, add the Registration Manager 
host to the browser Local intranet or Trusted sites list. In Internet Explorer, click 
Tools > Internet Options > Security. Select the appropriate web content zone. Enter 
the Registration Manager host (https://server.subdomain.com) in the text box and click 
Add.

Enabling Javascript and UTF-8 Encoding

You must enable JavaScript and UTF-8 encoding for web-based administration. If you 
do not enable both, some pages of Registration Manager may not be displayed 
properly.

In Microsoft Internet Explorer

1. To enable JavaScript:

a. Click Tools > Internet Options, and click the Security tab.

b. Select the appropriate web content zone.
If you are not sure which zone to select, you can enable JavaScript for all of 
the following zones: Internet, Local intranet, and Trusted sites.

c. Select the Security level for the zone.
If you are using the default security level, JavaScript is enabled. (JavaScript is 
enabled at the Low, Medium-low, and Medium levels.)
If you are using a custom security level, click Custom Level. Scroll down to 
Scripting > Active Scripting, and select Enable.
3: Overview of the RSA Registration Manager Web Interface 19
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2. To enable UTF-8 encoding, do one of the following:

• In Internet Explorer 6, click View > Encoding > Unicode (UTF-8), and clear 
Auto-Select.

• In Internet Explorer 7 to 9, click Page > Encoding > Unicode (UTF-8), and 
clear Auto-Select.

In Mozilla Firefox

1. To enable JavaScript, do one of the following:

• On Windows, click Tools > Options, and on the Content tab select 
Enable JavaScript.

• On Linux, click Edit > Preferences, and on the Content tab select 
Enable JavaScript.

2. To enable UTF-8 encoding, click View > Character Encoding > 
Unicode (UTF-8). You may want to set this as your default character set.

In Mozilla

1. To enable JavaScript:

a. Click Edit > Preferences > Advanced > Scripts & Plug-ins.

b. Under Enable JavaScript for, select Navigator.

c. Under Allow scripts to, select all options except Hide the status bar.

2. To enable UTF-8 encoding, click View > Character Encoding > 
Unicode (UTF-8). You may want to set this as your default character set.

Entering and Displaying International Characters

On Windows

To enter and display international characters in certificates, use Input Method Editors 
(IMEs).

To enable IMEs: 

• On Windows 2003, Windows XP, and Windows Vista, in the Control Panel, 
enable the relevant IMEs through Regional and Language Options.

• On Windows Server 2008 or Windows 7, in the Control Panel, enable the relevant 
IMEs through Clock, Language, and Region.

On Solaris

To enter and display international characters in certificates, in the /etc/default/init 
file, edit or add the relevant LANG, LC_CTYPE, and LC_COLLATE variables.

On Linux

To enter and display international characters in certificates, in the /etc/sysconfig/i18n 
file, edit or add the relevant LANG, SUPPORTED, and SYSFONT variables.
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Administration Server

The Registration Manager Administration Server is the interface through which you 
perform certificate management tasks.

To access the Administration Server, open your browser and go to 
https://host.subdomain.com:444/ra/index.xuda.

Note: The port numbers in this guide are the default numbers the software assigns at 
installation. The correct port number can be obtained from the Registration Manager 
Administrator if Certificate Manager was not installed with the default port numbers.

The Secure Directory Server of the target RSA Certificate Manager installation must 
verify the status and role of your certificate before you are allowed access to the 
Registration Manager Administration Server. If you have not yet requested a Vettor 
certificate, see Chapter 4, “Obtaining a Vettor Certificate.”

Note: The target Certificate Manager installation must be running and accessible to 
allow Registration Manager administrative certificates to access the Registration 
Manager Administration Server.

After your certificate is authenticated, the Registration Manager Welcome page opens.
3: Overview of the RSA Registration Manager Web Interface 21
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Administration Server Interface Layout

The Administration Server interface layout is divided into four areas.

Banner The Banner is displayed across the top of the browser window. Buttons 
in the Banner lead to each workbench. A link to the Help Index and a 
Refresh link are displayed below the Banner.

Navigation Area The Navigation Area is on the left side of the browser window. It has 
links to all of the functions that may be performed within the current 
workbench.

Message Area The Message Area is below the Navigation Area. When the mouse 
cursor moves over a button or link in the Banner or Navigation Area, 
information about the button or link is displayed here.

Content Area The Content Area is the largest part of the layout. Templates for the 
currently selected operation are displayed here. 
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Registration Manager also includes fully indexed and searchable online Help. You can 
access the Help by clicking the main ? Help link below the Banner. Help is available 
for all of the functions accessible through the Administration Server. A glossary of 
terms is also available. You can view version and license information by clicking the 
RSA logo.

Workbenches

The Administration Server is organized into four areas called workbenches, each 
accessible by clicking a button in the Banner. Vettors see only the Certificate 
Operations workbench, from which you can issue and manage certificates.

The Certificate Operations workbench provides Vettors all the functions for vetting 
certificate requests and managing issued end-entity certificates. These functions, 
accessed through hyperlinks in the Navigation Area, include:

• Finding and viewing active, approved, deferred, and refused certificate requests

• Vetting, deferring, and refusing certificate requests

• Finding and viewing active, suspended, and revoked end-entity certificates

• Issuing, suspending, reinstating, and revoking end-entity certificates

• Generating certificate reports and user counts

• Creating, finding, viewing, and deleting CMP shared secrets.
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Input Fields

Required Fields

It is often not necessary to enter values in every input field on a page. Some fields can 
be left empty.

Fields that require a value are marked with .

Input Validation

Where possible, Registration Manager performs input validation on values entered 
into the administration interface. Input validation ensures that all required fields have 
values and that only allowable values are entered. For example, if an input field 
requires a port number and you leave the field blank or enter characters other than 
numbers, Registration Manager does not allow you to continue the operation until you 
enter an appropriate value.

Fields that require a new value are marked with .

In Windows browsers, the Message Area provides information on the problem when 
the mouse cursor is over the warning symbol.
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Search Filters

Several pages in the Administration Server and Enrollment Server provide search 
filters for finding certificates and certificate requests. All of these filters function in a 
similar manner.

Jurisdiction The Jurisdiction that issued the certificates or to which the certificate 
requests were made, or All to indicate all Jurisdictions.

Status The status of the certificates or certificate requests. 

For certificates, the status can be All, Active, Suspended, or Revoked.

For certificate requests, the status can be All, Active, Approved, Deferred, 
or Refused.

Qualifier The field in the certificate or certificate request that you want to search on. 
The valid qualifiers include: No Qualifier, Common Name, Family 
Name, First Name, Personal Identifier, Domain Component, User ID, 
E-mail, Organizational Unit, Organization, Locality, State/Province, 
Country, Unstructured Name, Unstructured Address, Postal Address, 
Postal Code, Telephone, Facsimile, Date of Birth, Place of Birth, 
Gender, Country of Citizenship, Country of Residence, Pseudonym, 
and Title.

If you do not select a qualifier, the search row is ignored when you click 
Search.

is

begins with

contains

If you select is, the search string for the qualifier must match the value of 
the corresponding field in the certificate or certificate request.

If you select begins with, the search string for the qualifier must match the 
beginning of the value of the corresponding field in the certificate or 
certificate request.

If you select contains, the search string for the qualifier must match part of 
the value of the corresponding field in the certificate or certificate request.
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Note: After clicking List All or Search, if more than 100 matching objects are found, 
only the first 100 are displayed. Refine your search criteria and search again to reduce 
this number. 

Enrollment Server

To access the Enrollment Server, open your browser and go to 
https://host.subdomain.com:443/. The port number is optional if it is the default, 443.

If Registration Manager has access only to the initial target Jurisdiction, the 
Jurisdiction Options page for the target Jurisdiction opens. Its interface depends on the 
enrollment interface configurations defined in the Jurisdiction. If Registration 
Manager has access to more than one target Jurisdiction, the Enrollment Server 
Welcome page opens. For more information, see the RSA Certificate Manager 
Administrator’s Guide.

The Enrollment Server allows end users to enroll in the PKI by requesting certificates. 
The Enrollment Server is server-authenticated: it presents its certificate to end users to 
prove its identity, but does not require end users to provide a certificate to prove their 
identity.

Search String A value that matches the corresponding field in the certificate or certificate 
request that you are searching for. If you enter leading or trailing white 
space in the search string, it is ignored. The wildcard character * may be 
entered to represent any string of characters.

Note: The format for a date search string can be “DD/MM/YYYY” 
(including the slashes) or “YYYYMMDD”. The format for a gender search 
string can be “M”, “F”, “Male”, or “Female”.

And/Or If you set values for more than one search row, selecting And means that all 
of the conditions must be true. If you select Or, only one of the conditions 
must be true.

List All Clicking List All ignores all qualifiers and searches for all certificates or 
certificate requests matching the selected Status.

The exact text of this button may vary depending on what you are searching 
for. For example, if you selected a Status of Active, the button text is List 
All Active.

Search Clicking Search initiates a search for certificates or certificate requests that 
match your search criteria.
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Enrollment Server Interface Layout

The Enrollment Server is the end users’ interface to making certificate requests and 
managing their own certificates. For more information on accessing the Enrollment 
Server’s features, see Chapter 8, “Obtaining a Certificate” and Chapter 9, “Managing 
a Digital Certificate.”

The Enrollment Server interface provides access to Jurisdiction-based operations 
within target Jurisdictions. These operations may include:

• Requesting an end-entity certificate

• Requesting a PKCS #10 certificate

• CA Options—viewing, downloading, and saving certificates for CAs and 
revocation list signers, and saving revocation lists to a file

• End-entity certificate options—downloading and viewing end-entity certificates

• Renewing your client certificate

• Revoking your client certificate

Some of these operations may be inaccessible, depending on how the 
Certificate Manager Administrator has configured the target Jurisdiction enrollment 
interface.

Note: The target Certificate Manager installation must be running to allow end users 
to access CA options, end-entity certificate options, and renewal and revocation of 
client certificates from the Registration Manager Enrollment Server.
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4 Obtaining a Vettor Certificate

This chapter describes how to:

• Obtain your Vettor certificate

• Revoke your certificate

• Protect your private key

Obtaining Vettor Certificates

Before you can perform any Vettor tasks, you must obtain a Vettor certificate—an 
administrative certificate with the Vettor role.

To obtain a Vettor certificate, perform these procedures:

• Request a Vettor certificate.

• Retrieve and download your certificate.

Prerequisite for Internet Explorer

If you use Internet Explorer, you must change your browser settings to allow 
certificate request and installation.

To change the browser settings:

1. Click Tools > Internet Options.

2. On the Security tab, click Trusted sites > Sites.

3. Add the Enrollment Server URL to the list of trusted sites.

4. In Internet Explorer 9 only, on the Advanced tab, in the Settings list, under 
Security, ensure that Do not save encrypted pages to disk is cleared.

5. Click Apply, and click OK.

Important: In Internet Explorer 8 or 9 on Windows Vista, Windows 7, or Windows 
Server 2008, if the Web Access Confirmation pop-up window prompts you to allow 
digital certificate operations, click Yes.
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Requesting a Vettor Certificate

You cannot request an RSA Registration Manager Vettor certificate through the 
standard certificate request form. Your Administrator provides the URL of the 
administrative certificate request form on the Enrollment Server.

To request a Vettor certificate:

1. Click the administrative URL hyperlink (appropriate to your browser) provided 
by your Administrator.
The administrative certificate request form opens.

2. Enter the requested information in the certificate request form.
The initial target Jurisdiction defines the format of the certificate request form.

3. Make sure that Vettor Certificate is selected.
Vettor Certificate is the default selection.

4. (Optional) Select one or more Jurisdictions.
These are the Jurisdictions you want to be allowed to vet for. The final list may be 
different because this list can be edited by the Administrator vetting your request.

5. If you use Microsoft Internet Explorer, select a Cryptographic Service Provider.

6. Select a Key size.

7. If Protect Private Key is available, select Yes to make the key non-exportable or 
No to make the key exportable.

8. Click Submit.
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9. Depending on your browser, do one of the following:

• In Internet Explorer, if prompted, accept the default security level or select a 
security level.

• In Firefox or Mozilla, if prompted to enter a master password, create or enter 
the password.

If your request is accepted, your request is vetted by an Administrator and an e-mail 
notification may be sent to you (or another method for retrieving your certificate will 
be determined).

If your request is refused, you may resubmit your request or contact an Administrator 
for further instructions.

Downloading a Vettor Certificate

If the RSA Certificate Manager Administrator has enabled e-mail notification for the 
issuing Jurisdiction, you receive one of three possible e-mails from the Registration 
Manager Administrator who vetted your certificate request. The three possibilities are:

Deferred e-mail notification. Your Vettor certificate request has been deferred. 
You may need to contact the Administrator for the certificate to be issued.

Refused e-mail notification. Your Vettor certificate request has been refused. The 
reason for the refusal may be included in the e-mail. You must contact the 
Administrator for the certificate to be issued.

Approved e-mail notification. Your Vettor certificate is issued. You can proceed 
to download the certificate.

As a best practice, the issuing CA certificate chain of your Vettor certificate should be 
installed into your browser. Some browsers automatically install the certificate chain 
when you install your certificate. Some browsers require the root CA to be installed 
before installing the certificate chain. n Internet Explorer on Windows Vista, Windows 
7, and Windows Server 2008, Firefox, or Mozilla, you see a link to install the root CA 
certificate before you install your certificate chain. In other versions of Internet 
Explorer, the certificate chain, including the root CA, is automatically installed.

To download a Vettor certificate:

1. When you receive e-mail notification that your certificate has been issued, open 
the hyperlink using the same browser from which you submitted your certificate 
request.
The Certificate Download page opens.

2. If you use Internet Explorer on Windows Vista, Windows 7, or Windows 
Server 2008, follow these steps:

a. Click Install Client Certificate.

b. Click Install Root CA Certificate and follow the on-screen instructions to 
install the root CA certificate.

c. From the Where is this certificate being stored? drop-down list, select 
Personal store or Smart Card.
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d. Click Install Your Certificate. 
If prompted to allow certificates to be added or to install a CA certificate that 
is in your certificate signer chain, click Yes.
Internet Explorer downloads your certificate and displays a message 
confirming that your certificate has been installed.

3. If you use Internet Explorer on Windows XP or Windows Server 2003, follow 
these steps:

a. Click Install Client Certificate.

b. From the Where is this certificate being stored? drop-down list, select 
Personal store or Smart Card.

c. Click Install Certificate.
If prompted to allow certificates to be added or to install a CA certificate that 
is in your certificate signer chain, click Yes.
Internet Explorer downloads your certificate and displays a message 
confirming that your certificate has been installed.

4. If you use Firefox or Mozilla, follow these steps:

a. Click Install Root CA Certificate and follow the on-screen instructions to 
install the root CA certificate.

b. Click Install Client Certificate.
Your certificate is immediately installed. Mozilla may not display a 
confirmation message after installing the certificate.

If the issuing CA certificate or certificate chain was not installed with your Vettor 
certificate, manually install the issuing CA certificate or certificate chain from the 
Enrollment Server. For more information, see “Downloading the CA Certificate” on 
page 74.

Revoking Your Vettor Certificate

If you suspect that the security of your Vettor certificate has been compromised, you 
should revoke your certificate immediately. Revoking your certificate prevents an 
unauthorized party from using the “identity” that your certificate confers. (This is 
similar to revoking your credit card to prevent unauthorized use when the credit card’s 
security has been compromised.) It is important to revoke your certificate if either of 
the following circumstances occurs:

• The private key associated with your certificate is compromised (for example, if 
you lose your smart card).

• You accidentally renew the wrong certificate.

Consequences of Revoking a Certificate

After you revoke your certificate, you cannot access the Administration Server to 
perform your Vettor tasks. You must obtain a new certificate, or ask your 
Administrator to reissue the revoked certificate.

For more information on revoking your certificate, see “Revoking a Certificate” on 
page 84.
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Protecting Your Private Key

The private key associated with your Vettor certificate is an important 
client-authentication mechanism. It permits access to Registration Manager. To 
maintain the security of your organization’s registration authority, you must maintain 
the security of the private key associated with your certificate.

If anyone other than yourself gains access to your private key, the integrity of the 
entire registration authority is compromised. The integrity of your Vettor certificate 
requires that you, and only you, have access to your private key. Anyone who obtains 
your private key can compromise Registration Manager by accessing the restricted 
servers and performing privileged operations.

It is your responsibility to protect your private key by protecting your web browser 
(for example, with a smart card and password). When your smart card is not in use, 
carry it with you or lock it in a secure place. For more information on protecting your 
private key, see “Protecting Your Private Key” on page 79.

CAUTION: In addition to meeting or surpassing all the security precautions described 
in “Protecting Your Private Key” on page 79, you must meet your organization’s more 
stringent requirements for protecting a Vettor private key. Make sure that you are 
familiar with these requirements.
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Part 2. Certificate Management (Vettor) Tasks

Part 2 describes the tasks you, as a Vettor, perform on the Certificate Operations 
workbench to manage end-entity certificates for your Jurisdictions.

Part 2 consists of the following chapters:

• Chapter 5, “Vetting Certificate Requests”

• Chapter 6, “Managing Certificates”

• Chapter 7, “Certificate Management Protocol”
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5 Vetting Certificate Requests

The main tasks you perform as a Vettor are vetting certificates requests from 
end-entities and managing the certificates after they are issued by the certificate 
authority (CA). You perform these tasks within target Jurisdictions. 

The initial vetting process includes the following tasks:

• Reviewing certificate requests from end-entities

• Verifying the information the requests contain

• Taking the appropriate action for each request

Appropriate action for a certificate request includes the following:

• Approving a Certificate Request

• Deferring a Certificate Request

• Refusing a Certificate Request

• Deleting a Certificate Request

Your responsibilities also include managing certificates after they have been issued. 
For more information, see Chapter 6, “Managing Certificates.”

Before you can perform vetting tasks, obtain a Vettor certificate. For more 
information, see Chapter 4, “Obtaining a Vettor Certificate.”

Vetting End-Entity Certificates

Vetting an end-entity certificate includes the following tasks:

• Reviewing the end-entity certificate request according to your PKI policies

• Verifying the information in the request

• Editing the request, if needed and if the issuing Jurisdiction is configured to allow 
this

• Deciding the appropriate response

• Assigning extensions and extension values, if the issuing Jurisdiction is 
configured to allow this

Viewing a Certificate Request

The process begins when the end-entity sends a certificate request to Registration 
Manager. Depending on the configuration of the issuing Jurisdiction, you may be 
notified of a new request by e-mail. 
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The certificate requests are stored in four queues:

Active. Most certificate requests start here.

Approved. For certificate requests for Vettor-issued certificates.

Deferred. For Vettor-deferred certificate requests.

Refused. For Vettor-refused or malsigned certificate requests.

To view a certificate request:

1. Click Certificate Operations.
The View Requests screen opens.

2. Under Requests, click the appropriate hyperlink, that is, one of active, approved, 
deferred, or refused.
Verify that the status you selected is displayed in the Status drop-down list.
A status of All, Active, Approved, Deferred, or Refused can be selected from 
the list.

3. If Registration Manager has access to more than one Jurisdiction, select a 
Jurisdiction or All from the Jurisdiction drop-down list.

4. To display a list of all certificate requests of the selected status, click List All 
Status. 
To narrow the search, use the search filters. For more information, see “Search 
Filters” on page 25.
A table showing the results is displayed.
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5. Click the certificate request that you want to process.
The certificate request opens in a new window.
All attributes in the Subject DN of a PKCS #10 certificate request are displayed 
under Subject DN, whether or not they are configured in the Jurisdiction. If the 
attribute is recognized by Registration Manager, the attribute name and value are 
displayed. The value is editable. If the attribute is not recognized by Registration 
Manager, the attribute OID and a checkbox are displayed. To include the attribute 
in the certificate, select the checkbox. If an attribute is configured in the 
Jurisdiction to be stored with, but not in, the certificate, the attribute is displayed 
with a value under Subject DN and without a value under Not included in 
certificate. Both instances are editable.

6. Review the information on the request form, according to the standards and 
policies determined by your organization.
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7. Determine the appropriate response to the certificate request:

• To approve a certificate request, see “Approving a Certificate Request” on 
page 40.

• To defer a certificate request, see “Deferring a Certificate Request” on 
page 45.

• To refuse a certificate request, see “Refusing a Certificate Request” on 
page 45.

• To delete a certificate request, see “Deleting a Certificate Request” on 
page 46.

Approving a Certificate Request

You can issue a certificate for an active, approved, deferred, or refused certificate 
request.

Note: If the CA of the issuing Jurisdiction has been suspended or revoked, you cannot 
approve certificate requests. If you attempt to do so, you receive a message indicating 
the error.

To approve a certificate request and cause the CA to issue the certificate:

1. (Optional) Enter a Certificate Name.
Certificate names are not mandatory; however, they can be very useful for setting 
up web server ACL rules. For ease of reference, RSA recommends that the 
certificate name be the same value as the common name when possible. If you add 
a certificate name, it must be unique among all certificates issued by the CA of the 
issuing Jurisdiction. RSA Certificate Manager tests the uniqueness of the name 
and, if it is not unique, prompts for a new name.

2. If needed and if the Jurisdiction is configured to allow it, edit the required 
certificate attribute values (for example, Common Name, Organization, Country, 
or E-mail Address) to conform to the attribute configuration of the Jurisdiction.
For more information on all possible certificate attributes, see “Requesting a 
Certificate” on page 69.
An attribute that was included in a PKCS #10 certificate request and that is not 
recognized by Registration Manager is displayed as an OID with a checkbox. If 
you do not want to include this attribute in the certificate, clear the checkbox.

Note: A Certificate Manager Administrator may have configured some attributes 
for inclusion in the Subject Alternative Names or Subject Directory Attributes 
certificate extensions. If so, you can edit these now. You may also add extensions 
through the Client Certificate Extension Values page (see step 7).

It is possible for certain attributes to be included more than once, that is, in any 
combination of the Subject DN, the Subject Alternative Names certificate 
extension and the Subject Directory Attributes certificate extension. When the 
certificate is issued and the certificate database object is created, those attributes 
are saved only once. The value that is saved is taken from the Subject DN, the 
Subject Directory Attributes certificate extension, or the Subject Alternatives 
Names certificate extension, in that order.
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The X.509 certificate itself can contain different values for a single attribute that 
appears in different certificate locations (for example, a Common Name in the 
Subject DN can have a different value from a Common Name in the Subject 
Directory Attributes extension). However, the Registration Manager database 
only stores one value for the attribute, as described in the preceding paragraph. 
Even though an attribute is included in more than one part of the certificate, only 
one input box for the attribute is displayed on the Certificate Request form. 
Vettors can use the View Request page to change the values of an attribute that 
appears in different parts of the certificate.

3. If needed, update the Valid From field.

4. If needed, update the Valid Until field. 
You can enter a date and time or select a time period.

Important: When updating the validity period, choose a date that does not exceed 
the current date plus 25 years. If you choose a date beyond that, the message 
“[XrcBADVALUE] invalid or inappropriate value provided. Unable to sign 
certificate [invalid or inappropriate value provided]” is displayed. Click Back and 
select a date in the recommended range.

5. If the Jurisdiction has been configured to allow you to override the end-entity’s 
profile selection, edit the certificate profile and extension selection as needed.

Important: If the issued end-entity certificate will be used for encrypting and 
signing e-mail messages by a Microsoft Outlook user, select MS Exchange as the 
extension profile, although No Extensions is also acceptable. For more 
information, see the Using RSA Certificate Manager with Microsoft Exchange/ 
Microsoft Outlook – Administrator’s Guide.

The following figure shows an example of the Certificate extensions area of an 
end-entity certificate request.
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Important: The inclusion of some certificate extensions is optional and may be 
governed by your organization’s certificate policy (CP).

The Subject Directory Attributes certificate extension may be selectable from the 
Available Extensions list even though the information required to create it has 
been entered through the certificate attribute values. If you select this extension 
from the list and enter data on the Client Certificate Extension Values page after 
entering data through the certificate attribute values in step 2, all the OID-value 
pairs are merged into a single extension.

Some information needed for the Subject Alternative Names certificate extension 
cannot be entered through the certificate attributes values in step 2. Only 
rfc822name (EA), dNSName (DC), and directoryName (any attribute except EA 
or DC) can be entered through the certificate attribute values. The remaining 
fields must be entered through the Client Certificate Extension Values page, that 
is, the Subject Alternative Names extension must be selectable from the Available 
Extensions list. If it is not, contact a Certificate Manager Administrator.

The following figure shows an example of the Certificate extensions area of a 
PKCS #10 certificate request.

Important: To retain the extension value from the PKCS#10 request, select the 
extension from the PKCS10 Extensions column. To add a new extension or 
update a value, select the extension from the Mandatory Extensions or Available 
Extensions columns.

6. (Optional) If the Certificate Manager Administrator configured the Jurisdiction to 
send e-mail notification when a request is approved, add information to the 
standard message by entering it in the E-mail message to send with download 
URL field.

Note: Notifications for the Jurisdiction, if enabled, are displayed in underlined 
blue text in the e-mail notification area of the request. Click on the blue text to 
view the standard message.
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The following figure shows the E-mail notification area for a Jurisdiction with 
notification of approved requests enabled.

If e-mail notification was not enabled, a reminder displays saying that no e-mail 
will be sent to the end-entity.

7. Click Issue Certificate.
If a certificate profile is selected and one or more extensions are selected in the 
extension columns, the Client Certificate Extension Values page may open, 
depending on how the Certificate Manager Administrator has configured the 
profile. You may need to provide values for the extensions. For more information, 
see “Certificate Extensions” on page 100. Click Next for each page.

Important: When Key Usage extension is included in an end-user certificate 
(recommended in the S/MIMEv3 User certificate profile), select the 
key encipherment checkbox.
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The certificate is issued and the Certificate page opens.

If the Certificate Manager Administrator configured the Jurisdiction to send 
approved notification, e-mail notification, including the URL from which to 
download the certificate, is sent to the requestor.

Note: The e-mail notification is sent only once. It is not re-sent if the mail server 
is down during the first attempt.

You can click the buttons at the bottom of the View Certificate page to perform the 
associated operation on the viewed certificate. The following figure shows a sample 
representation.

For information about how to manage the status of certificates after they are approved 
and issued, see Chapter 6, “Managing Certificates.” For information about 
downloading certificates, see “Downloading Certificates” on page 46.
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Deferring a Certificate Request

If you want to postpone vetting a request until a later date (for example, to allow time 
to obtain more information), defer the request.

To defer the selected certificate request:

1. (Optional) If the Certificate Manager Administrator has configured the 
Jurisdiction to send e-mail notification when a request is deferred, add 
information to the standard message by entering it in the E-mail message to send 
with download URL field.
If the Certificate Manager Administrator did not enable e-mail notification, a 
reminder displays a message stating that no e-mail will be sent to the end-entity.

2. Click Defer.
The request is moved to the deferred request queue, where you or another Vettor 
can vet it at another time.

To update the certificate request after deferral, enter any new information and click 
Update.

Refusing a Certificate Request

If you do not want to issue a certificate, but want to maintain a record that the request 
was made, refuse the request.

Note: Registration Manager puts any unsigned certificate request or any certificate 
request with an invalid signature onto the refused request queue directly. The reason 
for the refusal is displayed on the status line of the certificate request.

To refuse the selected certificate request:

1. (Optional) If the Certificate Manager Administrator has configured the 
Jurisdiction to send e-mail notification when a request is refused, add information 
to the standard message by entering it in the E-mail message to send with 
download URL field.
If the Certificate Manager Administrator did not enable e-mail notification, a 
reminder displays saying that no e-mail will be sent to the end-entity.

2. Click Refuse.
The request is marked as refused in the database, which leaves a record that the 
request was made. A certificate is not issued. The request is moved to the refused 
request queue, where you or another Vettor can vet it at another time.
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Deleting a Certificate Request

If you do not want to issue the certificate, and do not need to maintain a record that the 
request was made, delete it.

Note: RSA recommends that you use this option only if the request was made for test 
purposes or in error.

To delete the selected certificate request:

• Click Delete.
The request is removed permanently from the database, leaving no record. A 
certificate is not issued.

Since deletion is normally used for test or erroneous certificate requests only, 
Jurisdictions cannot be configured to send e-mail notification for deleted requests.

Downloading Certificates

When viewing an end-entity certificate, the Download button opens a page that 
allows you to download the certificate with various formatting and encoding options. 
This operation can be performed at any time during a certificate’s validity period. The 
download format options are:

• PKCS #7 containing the certificate chain

• PKCS #7 without the certificate chain

• DER-encoded certificate without the certificate chain

The encoding options are:

• As a binary file

• As a PEM-encoded file
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To download an end-entity certificate:

1. If you are not currently viewing the certificate you want to download, follow the 
procedure in “Viewing a Certificate” on page 50.

2. Scroll to the bottom of the page and click Download.
The Certificate Download page opens.

3. Select one of the following download format options:

• PKCS #7 containing the certificate chain 

• PKCS #7 without the certificate chain 

• DER-encoded certificate without the certificate chain 

4. Select one of the following encoding options:

• Binary 

• PEM (Base64) 

5. Click Download Certificate, and save the certificate.
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6 Managing Certificates

This chapter describes tasks Vettors perform to manage certificates:

• Managing certificate status

• Certificate renewal policies

• Certificate reports

Certificates are issued and managed within a Jurisdiction.

Managing Certificate Status

An end-entity certificate has one of three statuses:

Active. The normal status for a certificate. Newly issued certificates are active, 
meaning they can be used to perform the functions for which they were issued.

Suspended. Makes a certificate temporarily invalid. Certificate suspension is like 
a temporary revocation. An end-entity who presents a suspended certificate is 
denied the PKI privileges the certificate would normally allow. For example, you 
can issue certificates to customers to access your web site. You can suspend the 
certificates of any customers with overdue accounts. You can then reinstate those 
certificates, after payment is made.

Revoked. Makes the certificate permanently invalid. If a certificate is revoked, 
the end-entity presenting the certificate is denied PKI privileges the certificate 
would normally allow. 

The nature of PKIs makes certificate revocation necessary. When a certificate is 
issued, an expiration period is embedded into the certificate. However, if the CA 
wants to retract the certificate before it expires, the certificate cannot be physically 
recalled. The concept of revoking a certificate was developed to handle this 
problem.

You can change the status of an end-entity certificate in the following ways:

Suspending. Changes the status from active to suspended and removes rights and 
privileges.

Reinstating. Changes the status from suspended to active, and returns the rights 
and privileges removed during suspension.

Revoking. Changes the status from active or suspended to revoked, and 
permanently removes all rights and privileges, but leaves the certificate in the 
database.
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Viewing a Certificate

To view a certificate:

1. Click Certificate Operations.

2. Under Certificates, click the appropriate status link: active, suspended, or 
revoked.
Verify that the status you selected is displayed in the Status drop-down list.
A status of All, Active, Suspended, or Revoked can be selected from the list.

3. Select a Jurisdiction or All from the Jurisdiction drop-down list.

4. Click List All Status to display a list of all certificates of the selected status or use 
the search filters to narrow your search for the certificate. For more information, 
see “Search Filters” on page 25.
A table showing search results is displayed.
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5. Click the link of the certificate you want to view.
The certificate opens in a new window.

6. Determine the appropriate action:

• To suspend a certificate, see “Suspending an End-Entity Certificate” on 
page 52.

• To reinstate a certificate, see “Reinstating an End-Entity Certificate” on 
page 53.

• To revoke a certificate, see “Revoking an End-Entity Certificate” on page 54.
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Suspending an End-Entity Certificate

Suspending a certificate changes its status from active to suspended in the database, 
and removes its PKI privileges.

To suspend an end-entity certificate:

1. View the certificate to be suspended, as described in “Viewing a Certificate” on 
page 50.

2. Scroll to the bottom of the screen and click Suspend.
A dialog box prompts you to proceed with the suspension. 

3. Click OK.
The Suspension Details page opens.

4. If needed, modify the invalidity time and date.
This is the time and date when you know or suspect that the certificate needed to 
be suspended. The default invalidity time and date is the current time and date.

5. (Optional) Enter a status change comment describing why you are suspending this 
end-entity certificate.
The comment cannot be longer than 1024 characters.
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6. Click Suspend.
The certificate is suspended. It can be reinstated or revoked at any time.
It is included in any subsequent complete CRLs and delta CRLs issued by the CA 
of the Jurisdiction with a reason code value of certificateHold. The reason code, 
invalidity date, and your status change comment are stored in the certificate object 
in the database.
Clicking Back instead of Suspend stops the suspension process.

Reinstating an End-Entity Certificate

Reinstating a certificate changes its status from suspended to active in the database, 
and enables the PKI privileges that were removed when the certificate was suspended.

To reinstate an end-entity certificate:

1. View the certificate to be reinstated, as described in “Viewing a Certificate” on 
page 50. 

2. Scroll to the bottom of the window, and click Reinstate.
A dialog box prompts you to proceed with the reinstatement.
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3. Click OK.
The Reinstatement Details page opens in a new window.

.

4. If needed, modify the reinstatement time and date.
This is the time and date when you know or suspect the certificate to be valid 
again. The default reinstatement time and date is the current time and date.

5. (Optional) Modify the status change comment describing why you are reinstating 
this end-entity certificate.
If a status change comment was entered when the certificate was suspended, it is 
displayed in the status change comment text box.

6. Click Reinstate.
The certificate status is returned to active. The corresponding entry in the 
complete CRL issued by the CA of the Jurisdiction is removed in the next 
complete CRL generation. The reason code in the corresponding entry in the delta 
CRL issued by the CA of the Jurisdiction is changed to removeFromCRL. The 
reason code, reinstatement date, and your status change comment are stored in the 
certificate object in the database. 
Clicking Back instead of Reinstate stops the reinstatement process.

Revoking an End-Entity Certificate

Revoking a certificate changes its status from active or suspended to revoked, in the 
database, and permanently removes all PKI privileges.

To revoke an end-entity certificate:

1. View the certificate to be revoked, as described in “Viewing a Certificate” on 
page 50.

2. Scroll to the bottom of the screen, and click Revoke.
A dialog box prompts you to proceed with the revocation.
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3. Click OK.
The Revocation Details page opens in a new window.

4. Select a reason code from the drop-down list.

5. If needed, modify the invalidity time and date.
This is the time and date when you know or suspect that the certificate required a 
change of status. The default invalidity time and date is the current time and date.

6. (Optional) Enter a status change comment describing why you are revoking this 
end-entity certificate.
The comment cannot be longer than 1024 characters.

unspecified No reason is given (default).

keyCompromise You know or suspect that the private key is compromised.

affiliationChanged Information in the certificate has changed, but you do not 
suspect that the private key is compromised.

superseded The certificate has been superseded, but you do not suspect 
that the private key is compromised.

cessationOfOperation The certificate is no longer needed for the purpose for which it 
was issued, but you do not suspect that the private key is 
compromised.

privilegeWithdrawn A privilege contained within the certificate has been revoked, 
but you do not suspect that the private key is compromised.
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7. Click Revoke.
The certificate is revoked and is included in any subsequent complete CRL and 
delta CRLs issued by the CA of the target Jurisdiction with the selected reason 
code value. The reason code, invalidity date, and your status change comment are 
stored in the certificate object in the database.
Clicking Back instead of Revoke stops the revocation process.

Reissuing an End-Entity Certificate

End-entity certificates can be reissued from the original certificate request that is 
stored in the database. For example, if the previously issued certificate is about to 
expire, or if a certificate was erroneously revoked, it can be reissued using the 
information from the original request.

If you reissue an end-entity certificate that is currently active, a new certificate is 
issued and recorded in the database. The new certificate has a new validity period, 
serial number, and MD5. The database keeps a record of both the previously issued 
certificate, and the new one.

Certificate reissuing is not affected by certificate renewal policies. For more 
information on renewal policies, see the following section, “Certificate Renewal 
Policies.”
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To reissue an end-entity certificate:

1. Click Certificate Operations.

2. Under Requests, click approved.

3. From the Jurisdiction drop-down list, select a Jurisdiction or All.

4. Use the search filters to narrow your search for the certificate request. For more 
information, see “Search Filters” on page 25.

5. Click the link of the certificate request from the list.

6. Review and, if needed, edit the information in the certificate request.

7. If profiles are available, select a profile from the list.

8. Click Issue Certificate.

9. If you selected any certificate profiles, enter or edit extension values as needed.
The certificate is issued and opens in a new window.
The new certificate is written to the database. If modified, the approved certificate 
request is updated in the database.

Note: After reissuing a new certificate, make sure to revoke the old certificate.

The end user must download the reissued certificate from the Enrollment Server.

Certificate Renewal Policies

Certificate renewal policies can be established to allow automatic renewal of 
certificates that have expired (or are about to expire), in response to a request from the 
certificate user. After a renewal policy has been established, end users can renew their 
own certificates without intervention by Vettors.

The Certificate Manager Administrator configures the certificate renewal policy for 
the Jurisdiction. This group renewal policy establishes renewal policies for all of the 
Jurisdiction’s certificates simultaneously. 

Certificate Manager Vettors can set individual certificate renewal policies that 
override the group renewal policy. Registration Manager Vettors cannot set individual 
renewal policies.

Requesting Certificate Renewal

If the Certificate Manager Administrator has configured the Jurisdiction to allow 
certificate renewal, end users can connect to the Registration Manager Enrollment 
Server prior to (or after) their certificate expiry date and submit a certificate renewal 
request. For more information, see “Renewing a Certificate” on page 87.

Certificate Expiry Notification

An Administrator can configure Registration Manager to send certificate expiry 
notifications on a Jurisdiction basis. The e-mail notifications inform end-users that 
their certificates have expired, or are about to expire, and how to renew certificates.
6: Managing Certificates 57



RSA Registration Manager 6.9 Vettor’s Guide
Certificate Reports and User Counts

Registration Manager generates two types of reports based on the criteria you specify: 
certificates and user counts. For example, you might want a list of certificates that are 
about to expire or the total number of users that have been issued certificates.

You can specify any of the following criteria for the certificates or users to be included 
in a report:

Jurisdiction. The issuing Jurisdiction.

Status. The certificate status.

Qualifying phrases. The value of selected certificate fields.

Validity start date. A date range when certificates become valid.

Validity end date. A date range when certificates become invalid.

Vettor. The Vettor who vetted the certificate request, including the CMP Server 
and the SCEP Server

Certificate reports contain:

• Date and time of the report

• Specified criteria

• Status, serial number, subject DN, validity start date, validity end date, and 
certificate profile name of each certificate, sorted in the order you specified

User counts contain:

• Date and time of the report

• Specified criteria

• Number of users found, based on unique subject DNs

• List of the subject DNs, sorted by DN

You can generate certificate reports in:

Comma-separated values (CSV) format. CSV reports are named 
report_YYYYMMDD.csv.

HTML format. HTML reports are named report_YYYYMMDD.html. 

User counts are generated only as a text file. User counts are named 
count_YYYYMMDD.txt. 

If more than one report is saved, an incremental number is appended to the filename.

For large reports that may take time to complete, you can send an e-mail when the 
report is complete. You enter the e-mail address when you generate the report. The 
e-mail contains a link to the report.

Note: If you use an external database, the number of records returned may be affected 
by the configuration of the external database.
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Generating Certificate Reports or User Counts

To generate a certificate report or a user count:

1. Click Certificate Operations.

2. Under Reporting, click reports.
The Certificate Reports page opens.

3. Specify the criteria for certificates included in the report or count:

a. From the drop-down list of Jurisdictions that Registration Manager accesses, 
select the issuing Jurisdiction.

b. In the Status drop-down list, select a certificate status.

c. (Optional) Specify up to three qualifying phrases.
If certificates must match all qualifying phrases, select And. If certificates 
must match any qualifying phrase, select Or.

d. (Optional) Specify a range of dates when certificates became valid. The date 
is specified in Greenwich Mean Time (GMT).

e. (Optional) Specify a range of dates when certificates become invalid. The 
date is specified in GMT.

f. (Optional) From the drop-down list, select a Vettor.

4. If you are generating a certificate report, from the Sort by drop-down list, select 
the certificate field on which to sort the results.
If you are generating a user count, it is sorted on the subject DN.

vettor The Vettor, identified by subject DN, who vetted the 
certificate requests.

Issued with CMP Certificates were issued by the CMP Server.

Issued with SCEP Certificates were issued by the SCEP Server.
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5. (Optional) Select Send completion email to and enter the e-mail address of the 
person to be notified when Registration Manager has generated the report or 
count.

6. If you are generating a certificate report, select Generate CSV report, Generate 
HTML report, or both.
If you are generating a user count, it is generated as a text file.

7. To generate a certificate report, do one of the following:

• Click Search and Report.
For searches that return fewer than 200 certificates, a page opens that displays 
a results table and a download link to the CSV report, the HTML report, or 
both.
The results table displays the certificate status, serial number, to whom the 
certificate was issued, subject DN, e-mail address, creation date, and expiry 
date.
Clicking a Certificate for link opens the View Certificate page of the selected 
certificate.
If a search returns more than 200 certificates, Registration Manager displays 
the first 200 certificates and does not generate a report. Click Back to return 
to the Certificate Reports page and click Generate Report.

• Click Generate Report.
For searches of any size, when Registration Manager has generated the report, 
a page opens that displays the number of certificates in the report and 
download links to the CSV report, the HTML report, or both.

8. To generate a user count, click Count Users.
A page opens that displays the number of unique subject DNs found and a 
download link to the user count.

Managing Certificate Reports or User Counts

To manage certificate reports and user counts:

1. On the Certificate Reports page, click View Reports or View User Counts.
A page opens that lists all saved reports.

2. Do one of the following:

• To download a report, click Download, and click Save in the dialog box that 
opens.

• To delete a report, click Delete.
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7 Certificate Management Protocol

This chapter describes how to configure the Certificate Management Protocol (CMP) 
shared secrets that are supported in RSA Registration Manager. 

Registration Manager offers certificate life cycle management using a subset of CMP. 
CMP defines message syntax and semantics that support certificate management, such 
as registration, revocation, key update, key recovery, and cross-certification. 

CMP protocol is specified in draft-ietf-pkix-rfc2510bis-04. CMP Transport is defined 
in the IETF draft-ietf-pkix-cmp-transport-protocols-04. An additional set of message 
formats specifically for certificate requests, called Certificate Request Message 
Format (CRMF), is listed in draft-ietf-pkix-rfc2511bis-02. RSA Certificate Manager 
Administrators set up implementation of CMP with Registration Manager. You need a 
basic understanding of the protocol itself, except for the area pertaining to shared 
secrets.

Using Key IDs and Shared Secrets

Certificate requests handled by the CMP Server contain a key ID, which identifies the 
requestor. The shared secret authenticates the certificate requestor. You can enter and 
edit shared secret information to determine the Jurisdiction and profile under which to 
issue a certificate. This information associates a Jurisdiction and profile with the key 
ID of an end user.

The key ID is a value agreed upon by the CMP client and the CMP Server. Requestors 
must know what their key ID is, but it is not necessarily a secret value. A company 
may, for example, use employees’ e-mail addresses as the key ID, which would not be 
a secret value. In this example, the company may then use the employees’ home 
telephone numbers as the shared secret.

The shared secret can be created by the certificate requestor or by you, depending on 
the organization. For example, a company may direct their employees to use their 
home telephone numbers as the shared secret; or a bank may direct its customers to 
use their ATM PINs as the shared secret. Or you could randomly create the shared 
secret, which would then require the value to be sent to the client.

End users provide their shared secret when requesting certificates. After they obtain a 
certificate, they can use signature-based protection.

Important: When you reject or revoke a certificate, you must also remove the 
certificate holder’s key ID (which was used to request that certificate) from the 
database or flat file. Otherwise, if holders of revoked certificates have access to your 
CMP server, they have the ability to use the same key ID to make a new request, 
effectively bypassing your CRL. To prevent such a security breach, you must purge 
the shared secret. Depending on the policy of your CA, you may then issue a new 
shared secret to that end user with which to make a new request. For more 
information, see “Managing Shared Secrets” on page 63.
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Creating Shared Secrets

To create a shared secret:

1. Click Certificate Operations.

2. Under CMP, click Shared Secrets.

3. On the CMP Shared Secret Search page, click Create New Shared Secret.
The CMP Shared Secret page opens in a new window.

4. Complete the fields, and click one of the following buttons.

Searching for Shared Secrets

To search for a shared secret:

1. On the CMP Shared Secrets Search page, select the Jurisdiction you want to 
search.

2. Do one of the following:

• Specify one or both of the search criteria (Key ID and Shared Secret) and 
click Search.

• Click List All.
The results table displays the key ID, Jurisdiction, profile, and shared secret of the 
records matching the search criteria.

Note: A maximum of 100 records can be displayed. If the search returns more 
than 100 records, you are prompted to refine your search criteria.

3. To view, modify, or delete the shared secret, or create a new shared secret, click 
the key ID of the shared secret.

Save and Close Saves the changes that were made and closes the window.

Save Saves the changes that were made and displays the shared secret 
editing window. For more information, see “Managing Shared 
Secrets” on page 63.

Close Closes the window without saving.
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Managing Shared Secrets

To manage shared secrets:

1. Search for the shared secret that you want to manage.

2. In the results table, click the key ID of the shared secret that you want to manage.
The shared secret information record is displayed.

3. To edit a record:

a. Edit any of the Jurisdiction, Profile, Shared Secret, POP Required, and 
Certificate DN fields. 

b. Click Save and Close or Save.

4. To create a new record using the current record as a template:

a. Click New.
Creating a new record changes the Key ID field from a read-only field to an 
editable field.

b. Click Save or Save and Exit.

5. To delete the record from the database, click Delete.
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Part 3. End-User Tasks

Part 3 describes the tasks end users perform at the RSA Registration Manager 
Enrollment Server to request and manage their certificates. It provides instructions for 
downloading other certificates that the end user may need, such as a CA or revocation 
list signer certificate.

Part 3 consists of the following chapters:

• Chapter 8, “Obtaining a Certificate”

• Chapter 9, “Managing a Digital Certificate”

• Chapter 10, “Trusting the Certificates of Others”
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8 Obtaining a Certificate

This chapter describes how you, as an end user, obtain a digital certificate and how 
you should protect the private key associated with it. After reading this chapter, be 
sure to read Chapter 9, “Managing a Digital Certificate” to learn how you can manage 
your certificate throughout its life cycle. 

You can request a certificate through RSA Registration Manager in the following 
ways:

• Through a browser connected to the Enrollment Server

• Through devices (such as routers) that use the SCEP protocol

• Through RSA Certificate Manager API-enabled applications. For more 
information, see the RSA Certificate Manager API Reference Manual.

The following sections describe how you obtain a digital certificate using a web 
browser to connect to the Enrollment Server when you want to obtain a certificate for 
use in a web browser or e-mail application, or for use in an application that produces 
PKCS #10 certificate requests.

Prerequisite for Internet Explorer

If you use Internet Explorer, change your browser settings to allow certificate request 
and installation. If you use Windows Vista or if you use Windows 7 or Windows 
Server 2008 and do not have a built-in administrator account, to enroll for and install a 
machine certificate, you must also disable User Account Control (UAC).

To change the browser settings:

1. Click Tools > Internet Options.

2. On the Security tab, click Trusted sites > Sites.

3. Add the Enrollment Server URL to the list of trusted sites.

4. In Internet Explorer 9 only, on the Advanced tab, in the Settings list, under 
Security, ensure that Do not save encrypted pages to disk is cleared.

5. Click Apply, and click OK.

Important: In Internet Explorer 8 or 9 on Windows Vista, Windows 7, or Windows 
Server 2008, if the Web Access Confirmation pop-up window prompts you to allow 
digital certificate operations, click Yes.
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To disable UAC in Windows Vista:

1.  Click Start.

2.  In the search field, type:

msconfig.exe

and press Enter.
If you're prompted for an administrator password or confirmation, type the 
password or provide confirmation.

3. In the System Configuration dialog box, click the Tools tab.

4. On Windows Vista or Windows Server 2008 (32-bit or 64-bit), follow these steps:

a. From the tools list, select Disable UAC.

b. Click Launch.

c. Click OK.

5. On Windows 7 or Windows Server 2008 R2, follow these steps:

a. Click Change User Account Control settings.

b. Click Launch.

c. Move the slider to the Never notify position.

d. Click OK.

6. Restart your computer.

Important:  After you have installed your certificate, re-enable UAC.

Certificates for Web Browsers and E-mail Applications

You need the following information before you can enroll for a certificate for a web 
browser or an e-mail application: 

• URL of the Enrollment Server

• Name of your Jurisdiction, if needed (the Jurisdiction may correspond to a 
department or division within your organization)

• Name of your cryptographic service provider (for Microsoft Internet Explorer 
browsers)

• Key size to select when requesting the certificate

• Whether to store your private key on a device such as a token or smart card

To obtain a certificate for a web browser or an e-mail application, perform the 
following tasks: 

1. Request a certificate.

2. Retrieve and download the certificate.

3. Download the certificate of the CA that signed your certificate if the issuing CA 
certificate chain was not installed with your certificate.
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Requesting a Certificate

Your first step is to submit a certificate request using your web browser. The request 
process varies slightly, depending on the browser and whether a token or smart card is 
available on your computer.

Note: If you intend to use the requested certificate for encrypting and signing e-mail 
messages in Microsoft Outlook, RSA recommends that you use Microsoft Internet 
Explorer as your browser and, if possible, select MS Exchange as the certificate 
profile if the target Jurisdiction has Microsoft Exchange/Outlook secure e-mail 
support enabled.

To request a certificate:

1. Connect to the Registration Manager Enrollment Server by entering the URL 
provided by the Vettor.

Note: The first time you connect to the Enrollment Server, you may be prompted 
to trust the authority that issued this secure site’s certificate. You must agree to 
trust it to proceed and connect to the Enrollment Server. (If the issuing authority’s 
trusted root certificate is already installed in your browser, you are not prompted.)

2. If the Welcome page opens, select your Jurisdiction from the drop-down list and 
click Continue.
The Jurisdiction Options page opens.
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3. Click Make an End-Entity certificate request.
The Certificate Request Form page opens.

4. Enter the requested information in the certificate request form.
Any of the following fields may be displayed, depending on the selected 
Jurisdiction.

Common Name Your first and last name (for example, Michael 
Montague). 

Country Your organization’s two-letter country (based on 
international standard ISO 3166 codes). For example, 
CA = Canada.

Country of Citizenship Your country of citizenship. For example, US = United 
States.

Country of Residence Your country of residence. For example, CA = Canada.

Date of Birth Your date of birth. For example, 15/07/1979.

Domain Component The components of the fully qualified domain name 
(FQDN). For example, DC = www, DC = rsa, DC = 
com.
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E-mail Address Your e-mail address. This address is where notification 
of certificate request approval will be sent, if the target 
Jurisdiction is configured for e-mail notification. For 
example, clee@rsa.com.

Facsimile Number Your company’s fax number.

Gender Your gender. For example, M = Male.

Given Name Your first name. For example, Michael.

jurisdictionOfIncorporation
CountryName

The jurisdiction (country) under which the business was 
incorporated. Used to identify the Jurisdiction of 
Incorporation for EV SSL certificates.

jurisdictionOfIncorporation
LocalityName

The jurisdiction (town) under which the business was 
incorporated. Used to identify the Jurisdiction of 
Incorporation for EV SSL certificates.

jurisdictionOfIncorporation
StateOrProvinceName

The jurisdiction (state or province) under which the 
business was incorporated. Used to identify the 
Jurisdiction of Incorporation for EV SSL certificates.

Locality The locality (the name of a region or city) where the 
organization is located. For example, Vancouver.

Organization Your company or organization name. For example, 
RSA.

Organizational Unit Your department. For example, Engineering.

Place of Birth Your place of birth. For example, Seattle.

Postal Address The organization’s mailing address. For example,

555 Burrard Street
Vancouver, British Columbia
CANADA

Postal Code Your organization’s postal code or zip code. For 
example, V7X 1M9

Pseudonym Your pseudonym. For example, Spike.

State or Province The state or province where your organization is 
located. For example, British Columbia.

Surname Your last name. For example, Montague.

Telephone Number Your organization’s telephone number.

Title Your title. For example, Principal Engineer.

User Identifier Your user identifier. It can be used to include additional 
information in the certificate, such as a membership or 
account number.
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5. If the Certificate Profile drop-down list is displayed, select No Extensions or, if 
available and appropriate, select a certificate profile for the certificate.

Important: Unless you have been told which profile to select, RSA recommends 
that you select No Extensions.

6. If you use Microsoft Internet Explorer, select a Cryptographic Service Provider.

7. Select a Key size.

8. If Protect Private Key is available, select Yes to make the key non-exportable or 
No to make the key exportable.

9. Click Submit.

10. Depending on your browser, do one of the following:

• In Internet Explorer, if prompted, accept the default security level or select a 
security level.

• In Firefox or Mozilla, if prompted to enter a master password to access a 
security device such as the built-in security device or a token, create or enter 
the password.

If your request is accepted, it is vetted by a Vettor and an e-mail notification may be 
sent (or there may be another method for you to retrieve your certificate).

If a request is refused, you may resubmit the request or contact your Vettor for further 
instructions.

Retrieving and Downloading The Certificate

Your second step is to retrieve and download your certificate. You can do this after 
you are notified that your request has been approved.

As a best practice, the issuing CA certificate chain should be installed into your 
browser. Some browsers automatically install the certificate chain when you install 
your certificate. Some browsers require the root CA to be installed before installing 
the certificate chain. If you use Internet Explorer on Windows Vista, Windows 7, or 
Windows Server 2008, Firefox, or Mozilla, and have installed the certificate of the 
root CA of the chain, the certificates of intermediate CAs are installed when your 
certificate is installed. If you use other versions of Internet Explorer, the issuing CA 
certificate chain is installed without you having to install the root CA certificate.

To download a certificate:

1. Using the same browser from which you submitted your certificate request, go to 
the URL indicated in the e-mail message. For example:
https://host.subdomain.com:enrollment-port/get-cert.xuda?
md5=issued certificate’s MD5&domainID=jurisdiction-id of issuing Jurisdiction
The Certificate Download page opens. It displays information about your 
certificate and the certificate itself in PEM-encoded format.

2. If you use Internet Explorer on Windows Vista, Windows 7, or Windows Server 
2008, follow these steps:

a. Click Install Client Certificate.
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b. Click Install Root CA Certificate and follow the on-screen instructions to 
install the root CA certificate.

c. From the Where is this certificate being stored? drop-down list, select 
Personal store, Local machine store, or Smart Card, as applicable.
If you do not use a smart card, your own certificate must go in the personal 
store. If you have requested a machine certificate, it must go in the local 
machine store.

d. Click Install Your Certificate.
If prompted to trust the ActiveX control for modification of your 
Microsoft Outlook client, RSA recommends that you click Yes (modifications 
are made automatically).

Note: If this is the first time this version of the ActiveX control is downloaded 
to your browser, the dialog box opens; otherwise, the cached version is used 
(no dialog box opens). The dialog box opens if the version is updated at a later 
date.

If prompted to allow certificates to be added or to install a CA certificate that 
is in your certificate signer chain, click Yes.
Internet Explorer downloads your certificate and displays a message 
confirming that your certificate has been installed.

3. If you use Internet Explorer on Windows XP or Windows Server 2003, follow 
these steps:

a. Click Install Client Certificate.

b. From the Where is this certificate being stored? drop-down list, select 
Personal store, Local machine store, or Smart Card, as applicable.
If you do not use a smart card, your own certificate must go in the personal 
store. If you have requested a machine certificate, it must go in the local 
machine store.

c. Click Install Certificate.
If prompted to trust the ActiveX control for modification of your 
Microsoft Outlook client, RSA recommends that you click Yes (modifications 
are made automatically).

Note: If this is the first time this version of the ActiveX control is downloaded 
to your browser, the dialog box opens; otherwise, the cached version is used 
(no dialog box opens). The dialog box opens if the version is updated at a later 
date.

If prompted to allow certificates to be added or to install a CA certificate that 
is in your certificate signer chain, click Yes.
Internet Explorer downloads your certificate and displays a message 
confirming that your certificate has been installed.
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4. If you use Firefox or Mozilla, follow these steps:

a. Click Install Root CA Certificate and follow the on-screen instructions to 
install the root CA certificate.

b. Click Install Client Certificate.
If prompted for a master password, enter the password.
Your certificate is immediately installed. Mozilla may not display a 
confirmation message after installing the certificate.

Downloading the CA Certificate

If the issuing CA certificate or certificate chain was not installed when you installed 
your certificate, you should manually install the issuing CA certificate or certificate 
chain from the Enrollment Server.

To download the CA certificate:

1. Using the same web browser from which you submitted your certificate request, 
connect to the Enrollment Server. (To do so, enter the same URL that you entered 
when you enrolled for your certificate.) 

2. If the Welcome page opens, from the drop-down list, select your Jurisdiction and 
click Continue.
The Jurisdiction Options page opens.

3. Click CA Options. 
The Signer Options page opens.

4. Under Install the CA or Revocation List Signer Certificate into a Browser, 
click Install CA Cert to download the CA certificate.

5. If you use Microsoft Internet Explorer:

a. Do one of the following:

• In earlier versions of Internet Explorer, you are prompted to either open 
the file or save it to a disk. Select Open this file from its current 
location and click OK.

• In later versions of Internet Explorer, in the File Download dialog box, 
click Save, then in the Download Complete dialog box, click Open.

Important: If Windows is not properly configured to manage the MIME type 
associated with certificates, the certificate is displayed as a jumble of ASCII 
characters. If this happens, connect to the Enrollment Server, click CA 
Options, and save the CA certificate in DER-encoded format. When 
prompted to open the file or save it to a disk, select Open this file from its 
current location. Then, complete step b and step c of this procedure to 
successfully install the CA certificate into Internet Explorer.

b. In the Certificate window, click Install Certificate.
The Certificate Import Wizard opens.
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c. Follow the prompts in the Certificate Import Wizard, selecting Automatically 
select the certificate store based on the type of certificate.

Note: The certificate store is where your browser stores downloaded 
certificates. It contains your certificates, certificates that you have accepted 
from other people and from web sites, and CA certificates that you trust.

6. If you use Firefox or Mozilla, in the Downloading Certificate dialog box, select 
the purpose for trusting this CA and click OK.

The CA certificate is now available for use in applications such as web browsers and 
e-mail clients.

Certificates for Other Applications

You may need to obtain a certificate for an application other than a web browser. In 
this case, you may use a protocol such as SCEP. For more information on obtaining a 
certificate through the SCEP Server, contact an Administrator.

If the application produces a PKCS #10 certificate request, you can submit the request 
through the Enrollment Server. The application must supply the file to be imported or 
the PEM encoding. To obtain a certificate from a PKCS #10 certificate request, you 
must do the following tasks:

1. Create a PKCS #10 certificate request and submit it to the Enrollment Server.
For more information, see the following section, “Making a PKCS #10 Certificate 
Request.”

2. After the certificate is issued, retrieve the certificate.
For more information, see “Retrieving the Certificate” on page 77.

3. Save the certificate of the CA that signed the certificate to a file.
For more information, see “Saving the CA Certificate to a File” on page 78.

4. Install the CA certificate for use by the application.
For more information, see the application documentation.

5. Install the requested certificate for use by the application.
For more information, see the application documentation.

Before you begin, you need the following information:

• URL of the Enrollment Server

• Name of your Jurisdiction, if needed
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Making a PKCS #10 Certificate Request

Prerequisite

Create a PKCS #10 certificate request. How this is done is determined by the 
application for which you are obtaining the certificate.

To submit a PKCS #10 certificate request:

1. Connect to the Enrollment Server using a web browser by entering the URL 
provided.

2. If the Welcome page opens, from the drop-down list, select your Jurisdiction and 
click Continue.
The Jurisdiction Options page opens.
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3. Click Make a PKCS #10 Certificate request.
The PKCS #10 Request page opens.

4. Paste your PEM encoding (including header and footer) into the text area 
provided, or click Browse to locate the file.

5. If the Certificate Profile drop-down list is displayed, select a certificate profile for 
the certificate.

Important: Unless you know exactly which profile to select, select 
No Extensions.

6. Supply additional information, if requested.

7. Click Submit PKCS #10 Request. 

Retrieving the Certificate

When the certificate has been issued, you must retrieve it according to your 
application’s instructions.

In most cases, this involves connecting to the Enrollment Server, selecting a 
Jurisdiction, and then clicking End-Entity Certificate Options. This allows you to 
search for the certificate that was issued in response to the PKCS #10 request. To 
perform the search, you must know the exact Common Name (CN), e-mail address, 
organization, organizational unit, or other distinguished name (DN) component. 
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In the search results table, you can click View Options. When you view the 
certificate, you have the option of copying and pasting the PEM-encoded certificate 
into your application, or saving it in a p7b format (for Windows Vista and most 
browsers) or p7c format (for Windows Address Book).

From the same page, you can download the CA certificate or the CA certificate chain 
to a file.

If the Certificate Manager Administrator has configured the issuing Jurisdiction to 
send e-mail notification when a request is approved, you may receive an e-mail 
message containing a hyperlink where you can download your certificate. For more 
information, see “Retrieving and Downloading The Certificate” on page 72.

Saving the CA Certificate to a File

If the issuing CA certificate or certificate chain was not installed when you installed 
your certificate, you should download the certificate of the CA that signed your 
certificate.

To download the CA certificate and save it to a file:

1. Connect to the Enrollment Server using a web browser by entering the same URL 
that you used when you requested your certificate.

2. If the Welcome page opens, from the drop-down list, select your Jurisdiction and 
click Continue.
The Jurisdiction Options page opens.

3. Click End-Entity Certificate Options. 
The End-entity certificate search page opens.

4. From the drop-down lists in the left column of the table, select one or more 
identifying attributes of your certificate. For more information on which operator 
to select, see “Search Filters” on page 25. Select and fill in as many attributes as 
you need in order to narrow your search. 
A table displays all certificates that match your search criteria.

5. Click the View Options hyperlink of your certificate. 
The View and Download Certificate page opens, displaying information about the 
certificate and the certificate itself in PEM-encoded format.

6. Scroll down and click Download Issuing CA Certificate or Download CA 
Certificate Chain.

7. Save the file.

Note: By default, the filename provided is the nickname of the CA certificate. If 
you want, you can change this name before or after you save the file to your 
machine.

The CA certificate is saved to a file. You can import this file into web browsers, e-mail 
clients, VPN clients, and other PKI-enabled applications.
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Protecting Your Private Key

The private key that corresponds to the public key in your certificate is used for 
digitally signing documents and proving your identity to secure servers (for example, 
servers that host sensitive or high-value business transactions on Internet web sites or 
on your organization’s intranet or extranet).

You must carefully protect your private key, just as you would protect your credit card, 
driver’s license, or passport.

Organizations establish a security policy that is outlined in a Certification Practice 
Statement (CPS). The CPS defines the specific security practices that the organization 
requires of its members and employees. You must be sure to meet the standards set 
forth in your organization’s CPS. For further information, you can consult your 
organization’s security officer.

As a certificate holder, you must exercise due diligence in protecting access to the 
private key associated with your certificate. This means that you must:

• Protect the local key/certificate store on your web browser

• Protect your key/certificate storage device from loss or theft

• Protect your private key against all forms of attack

• Transport your private key securely, if at all

• Report any suspected compromise of your private key promptly

• Revoke your certificate if you think the private key has been compromised

Protecting Your Local Keystore

Your key/certificate store may reside in a hardware device (such as a smart card) or in 
part of your software (such as the web browser certificate store). It is essential to 
protect your key/certificate store with strong authentication. Strong authentication 
means choosing strong passwords, changing them frequently, storing and transporting 
them securely, and, ideally, using the passwords in combination with a second form of 
authentication, such as an RSA SecurID smart card.

Choosing Good Passwords

Good passwords are typically at least eight characters long and contain a combination 
of uppercase and lowercase alphabetic, numeric, and non-alphanumeric characters. 
Good passwords are also changed at frequent intervals. The requirements for strong 
passwords are even more stringent. You must meet the specific standards set forth in 
your organization’s security policy and CPS. Those standards may be more stringent 
than the standards mentioned here.

Protecting Passwords

It is important not only to choose good passwords, but also to protect them. An entire 
security system can be breached at any weak link. For example, even an advanced 
security deployment can be compromised if you or other members of your 
organization write passwords on sticky notes and then leave them attached to a 
computer monitor, or in a file labeled “Passwords”.
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Storing Passwords Securely

Because passwords are stored in memory, you can heighten security if you:

• Lock your workstation before leaving it, even momentarily

• Frequently clear your browser cache

• Never allow others access to your computer

These practices prevent intruders from accessing your browser database and obtaining 
a copy of your password or private key. 

Using Passwords with a Second Form of Authentication

It is generally recognized that the use of passwords alone is insufficient where strong 
authentication is needed. In this case, two-factor authentication is recommended. 
Two-factor authentication makes use of a strong password in combination with a 
second form of authentication, such as an RSA SecurID smart token or smart card.

Protecting Your Key Storage Device from Loss or Theft

It is important that you protect your key/certificate store physically. This means 
protecting your smart card from loss or theft. You must store it securely when it is not 
in use. This also means not giving others access to your smart card, and limiting 
access to any other machine on which your certificate store or virtual smart card may 
be located.

Protecting Against All Forms of Attack

You must protect your private key against all forms of attack that are under your 
control. Attacks could take the form of shoulder surfing, social engineering, theft, or 
cryptoanalytic (mathematical) attack. You must:

• Never share a password or allow it to be discovered; for example, by entering it 
when someone else can see it (“shoulder surfing” attack). 

• Never allow your password to be discovered by someone (even an Administrator) 
convincing you that there is a good reason to tell it to them (“social engineering” 
attack).

• Never write your password down where it can be discovered by another person 
(“theft” attack).

• Change your password frequently (this lessens the possibility of a “brute force” 
attack, where someone guesses it or discovers it through systematic attempts to 
crack it).

• Never keep the same private key for long periods of time, especially if you use it 
for sensitive transactions. Instead, change it frequently, according to your 
organization’s policies (this lessens the possibility of a “mathematical” attack). 

• Never replicate your key and make it available to another person.
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Transmitting Your Private Key Securely

If your private key is exportable and you need to export your private key to another 
computer or application, transmit the key securely. You must:

• Never transmit your private key over an unsecured channel (such as regular 
e-mail). Instead, you must transmit it out-of-band. (For example, carry it on a 
floppy diskette to your different devices.)

• If you use PKCS #12 key interchange format, make sure that you properly clean 
up the PKCS #12 files afterwards, in each application and on each device, because 
the private key is contained in the PKCS #12. 

• Protect your PKCS #12 file with a strong password.

Acting Promptly if You Suspect Compromise

You must promptly report any suspected compromise of your private key. You must 
take steps to revoke your compromised certificate immediately. You can revoke your 
own certificate even before contacting a Vettor. For more information, see “Revoking 
a Certificate” on page 84.
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9 Managing a Digital Certificate

This chapter describes how you, as an end user, should manage a digital certificate 
throughout its life cycle:

• Select the certificate to connect to a secure web site

• View information in the certificate (for example, the CA that signed it or the 
expiration date)

• Export the certificate to another application (for example, if you want to switch 
from one browser to another)

• Revoke the certificate (for example, if the private key has been compromised)

• Renew the certificate if it is about to expire

• Request that the certificate be reissued if you accidentally revoke the wrong 
certificate

• Download the certificate again (for example, if your certificate store is damaged 
or destroyed)

Selecting a Certificate

When you attempt to connect to a client-authenticated secure web site, you cannot 
gain access to the site until you identify yourself with a digital certificate. Your 
browser may automatically select the appropriate certificate or may prompt you to 
select a certificate. By default, Firefox and Mozilla automatically select the certificate 
to present. If you have more than one certificate from the same issuing body, these 
browsers may select the wrong certificate. In this case, you must change the browser 
settings so that the browser prompts you to select a certificate to identify you to a 
secure web site.

Viewing Certificate Information

You can view the public information in your certificate or in the certificate that any 
other party (including a web server) presents to your browser. Viewable information 
includes the distinguished name (DN) of the certificate subject, serial number, 
expiration date, and information about the CA that issued (signed) the certificate. It 
may also include version number, key usage, authority key identifier, signature 
algorithm, thumbprint, thumbprint algorithm, intended purpose of the certificate, and 
possibly the certification path.

The procedure for viewing certificate information depends on the browser you use. 
For more information, you can refer to the browser documentation.
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Exporting a Certificate

For practical reasons, you may want to use the same certificate on multiple computers 
or with multiple applications. For example, you may want to use the same certificate 
for two different web browsers or if you are switching browsers. Also, you may want 
to use the same certificate on your laptop computer as on your computer at work.

Using the same certificate simplifies the task of decrypting encrypted messages that 
you receive, whether on your computer at work, your laptop while travelling, or a 
handheld device at home. It also allows you to have the same identity, whether signing 
an e-mail message, signing a workflow document, or identifying yourself to a web 
server.

To use your certificate on multiple computers or with multiple applications, you can 
export your certificate and private key to a file and then import it into the desired 
application.

Important: When you export your certificate, you are also exporting your private key. 
For more information, see “Transmitting Your Private Key Securely” on page 81.

Revoking a Certificate

If you suspect that the security of your certificate has been compromised, you should 
revoke your certificate immediately. Revoking a certificate helps prevent an 
unauthorized party from using the “identity” that the certificate confers. (This is 
similar to canceling a credit card because it has been stolen.) It is important that you 
revoke your certificate if either of the following circumstances occurs:

• The private key associated with the certificate is compromised (for example, if 
you lose your smart card).

• You accidentally renew the wrong certificate.

If you use your certificate with Microsoft Outlook 2003 or 2007, Microsoft Internet 
Explorer 5.0 to 9.0, Mozilla Firefox 2.0 to 3.6.13, or Mozilla 1.7, you can revoke your 
own certificate immediately without having to contact your Vettor first.

Consequences of Revoking a Certificate

After you revoke your certificate, the certificate cannot be reinstated. You can no 
longer sign e-mail or other documents with the revoked certificate. Also, you can no 
longer authenticate your identity to a requesting authority (such as a secured web site) 
with that certificate. To perform any of these actions, you must obtain a new certificate 
or have the revoked certificate reissued.

After revoking a certificate, you can still use its private key to decrypt and read e-mail 
messages or other documents that were encrypted with the public key before the 
certificate was revoked. Other people can continue to use the revoked certificate to 
verify your digital signature on documents signed prior to the revocation (depending 
on their application). Some applications prevent the use of revoked certificates.

Note: If you accidentally revoke your certificate, you can request that it be reissued.
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Revoke a Certificate

To revoke a certificate, you need the following information:

• Web address (URL) of your organization’s Enrollment Server

• Name of your Jurisdiction, if needed

You must present your certificate and prove that you have the corresponding private 
key before you can revoke the certificate. This requirement prevents someone other 
than you from accidentally or maliciously revoking your certificate.

Prerequisite

If you have more than one certificate issued from Certificate Manager, Firefox or 
Mozilla may select the wrong one to identify you to the web site to revoke your 
certificate. In this case, configure the browser to prompt you to select a certificate 
when you connect to a web site that requires certificate authentication.

To revoke your certificate:

1. Close any open browser windows and open a new browser session.

2. Connect to the Enrollment Server through the same URL that you used to request 
the certificate.

3. If the Welcome page opens, from the drop-down list, select the Jurisdiction and 
click Continue.
The Jurisdiction Options page opens.

4. Click Revoke your client certificate.
If you use Microsoft Internet Explorer, a warning may be displayed that you 
cannot revoke your certificate if it is suspended or revoked, or if the CA that 
signed the certificate is suspended or revoked. If either of these are the case, 
contact your Vettor for further instructions. Click OK.

5. If prompted to select a certificate to identify you to the web site, select the 
certificate that you want to revoke and click OK.
The Confirm Certificate Revocation page opens.

Note: All of the certificates in your browser database issued by Registration 
Manager are displayed, regardless of Jurisdiction. You can select any certificate 
(issued to you) for revoking, including certificates issued by a different 
Jurisdiction than you selected in step 3. You may need to make this selection 
twice.

6. Review the certificate information displayed to make sure that you are revoking 
the correct certificate.
If you do not want to revoke this certificate at this time, click Back.

Note: If the wrong certificate is displayed, begin the revocation procedure over 
again from step 1. Clicking Back does not allow you to select another certificate 
for revocation.
9: Managing a Digital Certificate 85



RSA Registration Manager 6.9 Vettor’s Guide
7. Click Revoke Certificate.
The Revocation Details page opens.

8. Select a reason code.

9. If needed, modify the invalidity date and time.
This is the date and time when you know or suspect that the certificate required a 
change in status. The default invalidity date and time is the current date and time.

10. (Optional) Enter a status change comment describing why you are revoking your 
certificate.
The comment cannot be longer than 1024 characters.

11. Click Revoke.
The certificate is revoked and a confirmation message is displayed. The reason 
code, invalidity date, and the status change comment are stored in the certificate 
object in the database.

unspecified No reason is given (default).

keyCompromise You know or suspect that the private key is compromised.

affiliationChanged Information in the certificate has changed, but you do not 
suspect that the private key is compromised.

superseded The certificate has been superseded, but you do not suspect 
that the private key is compromised.

cessationOfOperation The certificate is no longer needed for the purpose it was 
issued, but you do not suspect that the private key is 
compromised.

privilegeWithdrawn A privilege contained within the certificate has been 
withdrawn, but you do not suspect that the private key is 
compromised.
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Renewing a Certificate

If you use your certificate with Microsoft Internet Explorer 5.0 to 9.0, Mozilla 
Firefox 2.0 to 3.6.13, Mozilla 1.7, or an appropriate custom application, you may be 
allowed to renew your certificate using the Enrollment Server. Ability to renew your 
certificate depends upon the certificate renewal policy for your Jurisdiction or for your 
individual certificate.

You cannot renew a certificate that has been revoked.

You may or may not receive an e-mail notification just before your certificate is due to 
expire. By default, the e-mail message provides a URL to an Enrollment Server page 
that displays a hyperlink to renew the client certificate. 

You must present the certificate that you want to renew before you can renew the 
certificate. This ensures that the correct certificate is renewed. 

If you are allowed to renew your certificate, it is vetted automatically without 
intervention by a Vettor. Any certificate extensions are copied from the old certificate 
to the renewed certificate. They are not regenerated at the time the certificate is 
renewed.

When your certificate is renewed, the old certificate remains valid until its expiration 
date (unless it has already expired). RSA recommends that you delete your old 
certificate from your browser after the new certificate is valid.

If you accidentally renew the wrong certificate, you should revoke it immediately. 

Prerequisite

• Internet Explorer 8 and 9 do not display your expired certificates in the 
Certificates dialog box. To be renewed, expired certificates must be displayed in 
the browser. To display expired certificates in the browser, you must make the 
following registry change: in 
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Internet 
Explorer\MAIN\FeatureControl], add 
"Feature_ClientAuthCertFilter"=dword:00000002.

• If you have more than one certificate issued from Certificate Manager, Firefox or 
Mozilla may select the wrong one to identify you to the web site to renew your 
certificate. In this case, configure the browser to prompt you to select a certificate 
when you connect to a web site that requires certificate authentication.

To renew a certificate through the Enrollment Server:

1. Close any open browser windows and open a new browser session.

2. Connect to the Enrollment Server through the same URL that you used to request 
the certificate.

3. If the Welcome page opens, from the drop-down list, select a Jurisdiction and 
click Continue.
The Jurisdiction Options page opens.
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4. Click Renew your client certificate.
If you use Internet Explorer, a warning may be displayed that you cannot renew 
your certificate if it is suspended or revoked, or if the CA that signed the 
certificate is suspended or revoked. If either of these are the case, contact your 
Vettor for further instructions. Click OK.

5. If prompted to select a certificate to identify you to the web site, select the 
certificate that you want to renew and click OK.

Note: All of the certificates in your browser database issued by Registration 
Manager are displayed. You can select any certificate (issued to you) for 
renewing, including a certificate issued by a different Jurisdiction than you 
selected in step 3. 

The Client Certificate Renewal page opens.

6. Review the certificate information presented to make sure you are renewing the 
correct certificate. 

Note: If the wrong certificate is displayed, begin the renewal procedure again 
from step 1. Clicking Back does not allow you to select another certificate for 
renewal.

7. Click Renew Certificate.
The Certificate Download page opens.

8. Click Install Client Certificate.
If the end-entity certificate to be renewed is currently used for encrypting and 
signing e-mail messages in Microsoft Outlook, you may be prompted to trust the 
ActiveX control for modification of your Microsoft Outlook client. RSA 
recommends that you click Yes (modifications are made automatically).
Depending on your browser, the renewed certificate may be installed in your 
browser, or you may have to download it into the browser.

Reissuing a Certificate

You may want to request that your certificate be reissued if you revoked it in error. 
You must contact your Vettor to make this request. Your Vettor uses your old 
certificate request to reissue your certificate. When a certificate is reissued, any 
attribute (including the serial number and validity period) may change, except the key 
pair, which remains the same.
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Downloading a Certificate Again

You may need to download an existing certificate again (for example, if your 
certificate store is lost or destroyed). This could occur due to a software failure or 
damage to computer hardware. Depending on your browser, if you delete your 
certificate from your certificate store, you may delete the private key. In that case, you 
must apply for a new certificate.

Before you can download a certificate, you need the following information:

• Web address (URL) of your organization’s Enrollm, for example, the name, 
organizational unit, or e-mail address of the certificate subject (in this case, 
yourself)

If you know this information, you can download a certificate that was issued either to 
you (your private key must not be corrupted) or to another person.

To download a certificate: 

1. Connect to the Enrollment Server by entering the same URL you used when you 
requested a certificate. 

2. If the Welcome page opens, from the drop-down list, select a Jurisdiction and 
click Continue.
The Jurisdiction Options page opens.

3. Click End-Entity Certificate Options.
The End-Entity Certificate Search page opens.

4. From the drop-down lists in the left column of the table, select one or more 
identifying attributes of the certificate that you want to download. For more 
information on which operator to select, see “Search Filters” on page 25. Select 
and fill in as many attributes as you need in order to narrow your search. 
A table displays all certificates that match your search criteria.
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5. To verify that this is the certificate that you want to download, click the View 
Options hyperlink.
The View and Download Certificate page opens, displaying information about the 
certificate and the certificate itself in PEM-encoded format.

6. Install the certificate or download it in the format that you need. You can also 
download the CA certificate or the CA certificate chain to a file.
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10Trusting the Certificates of Others

This chapter provides important information about verifying the digital certificates 
that other persons and organizations (or even applications and hardware devices) 
present to you when you conduct electronic communications or other transactions. 

For any organization’s security system to function effectively, all users within the 
system must carefully follow the procedures established in that organization’s security 
policy. Failure of a single user to do so can compromise the security of the entire 
organization. 

You must carefully check all digital certificates that are presented to you, rather than 
blindly authorizing your web browser (or other applications) to accept, or “trust,” 
these certificates. This includes checking the certificates of persons with whom you 
communicate by e-mail and web sites that you connect to over the Internet.

Secured Communications

A secured web site presents visitors with a digital certificate that attests to the 
authenticity of the site. It is important to verify the validity of such a certificate before 
you proceed.

Note: Whenever you visit an Internet web site that is not secured, there is the 
possibility that a fraudulent person or organization may be “spoofing” the site. That is, 
they may be pretending to be the site of the organization that you are trying to contact. 
Unless the site presents your browser with a valid digital certificate, you cannot be 
certain that you are dealing with the organization with which you want to do business.

Similarly, if you receive an encrypted or digitally signed e-mail communication, it is 
important to carefully check the sender’s certificate before proceeding. The steps 
involved in checking a certificate are described in the following sections.

Checking a Certificate

It is important for you to follow your organization’s security policies for checking 
certificates. Although certificate checking can be performed partly by software 
applications, the human decisions that are made are critical to the organization’s 
security system.

A human decision is required when your browser prompts you to answer the following 
question:

• Should I trust the authority that issued this certificate?
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After you specify whether to trust the authority that issued the certificate, your 
browser or other application must determine the answer to the following questions:

• Is the certificate current?

• Is the certificate signature valid?

• Is the certificate authorized for this use?

• Has the certificate been revoked or suspended?

If your application determines that a certificate is not valid for any of the above 
reasons, you must not accept, or trust, the certificate.

Should I Trust the Issuing Authority

Before you can trust a certificate that is presented to you, you must first trust the 
authority that issued that certificate. 

As an example, when you attempt to connect to a secure Internet site with your web 
browser for the first time, the site presents its certificate to your browser for 
authentication (that it really is the site it claims to be). Your browser looks in its 
certificate store. If it cannot find the public key of the authority that issued the site 
certificate, your browser displays the message that it does not “recognize” the web 
server that hosts the site. Your browser asks if it should trust the site anyway.

If you specify to your browser that it should trust the site anyway, your browser trusts 
that server certificate, regardless of whether it trusts the authority that issued the 
certificate.

This action should not be performed without careful consideration. It may be 
advisable for you to check with your organization’s PKI administrator before you 
authorize your browser (or other application) to trust a server that it does not 
recognize. Otherwise, you may be providing a fraudulent party with an open door into 
your organization’s security system.

Is the Certificate Signature Valid

After you or your application determines whether the issuing authority can be trusted, 
your browser (or other application) automatically checks to see if the certificate was 
genuinely signed by the trusted issuing authority it references. If it was, the certificate 
is considered to be valid.

Is the Certificate Current

After an application determines whether a certificate signature is valid, it checks the 
certificate validity dates to verify whether the certificate is current. A current 
certificate is one that has not expired and is within a current validity period. That is, 
the validity period has already begun, but has not yet ended. 

If the certificate is not within a current validity period, your browser returns an error 
message. It is important not to proceed if the certificate validity dates are not current. 

Is the Certificate Authorized for This Use

An application must also verify that the presented certificate complies with its 
intended use and with any policy constraints specified by the issuing authority.
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A certificate should be used only for the purpose for which it was created. For 
example, a certificate created for use in signing applications only (to prove 
authenticity) should not be used for encrypting data. 

Additionally, an issuing authority may apply certain policy constraints to a certificate. 
This is done by marking certain fields in the certificate as critical or non-critical. To 
validate a certificate, an application must understand and correctly interpret the 
presence and content of those fields that are marked as critical. 

Has the Certificate Been Revoked or Suspended

Even when all information within a certificate is valid (for example, the certificate is 
genuinely signed by the issuing authority that it references and the validity period is 
current), an application should also check to see whether the certificate itself has been 
revoked or suspended. 

A certificate can be revoked for a variety of reasons, including a change in the 
certificate holder’s status (for example, termination of employment or transition to 
another department), compromise of the private key, and compromise of the issuing 
authority’s private key. A certificate can be suspended for similar or other reasons.

A revoked or suspended certificate should never be accepted, or trusted. 

Certificate Revocation Lists

Certificate authorities (issuing authorities) publish a list of all certificates that they 
revoke or suspend. This list is called a complete Certificate Revocation List (complete 
CRL). To check the revocation or suspension status of a certificate using a complete 
CRL, an application must examine the complete CRL published by the authority that 
issued the certificate. Along with a complete CRL, certificate authorities may publish 
a delta CRL, a list of certificates that have been revoked or suspended since the last 
complete CRL was published.

Authority Revocation Lists

Certificate authorities (issuing authorities) publish a list of all CA certificates that they 
revoke or suspend. This list is called an Authority Revocation List (ARL). To check 
the revocation or suspension status of a CA certificate using an ARL, an application 
must examine the ARL published by the authority that issued the CA certificate.

Downloading Revocation Lists

An advantage to downloading complete CRLs, delta CRLs, and ARLs is that you can 
check revocation status offline. However, the revocation lists may not be as current as 
status checked online, and they may require more storage space.

If you plan to check certificate revocation status offline, you can download the 
appropriate revocation list to your browser or, if you are using an application other 
than a web browser, save the revocation list to a file and then import it into your 
application. For more information, see “Downloading Revocation Lists” on page 95.

You must download the revocation list that is issued by the same authority that issued 
the certificate you are checking (or by an issuer specified in the CRL Distribution 
Points extension in the certificate). To ensure that your information is as current as 
possible, you must download revocation lists as frequently as they are issued.
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To verify the authenticity of the revocation list information that you receive, you must 
be sure to download the revocation list signer’s certificate to your browser or other 
application. For more information, see “Validating Revocation List Information” on 
page 96.

Important: When you validate a certificate, you should be sure to consider the date at 
which the latest revocation list was published. For a high-value transaction, for 
example, timeliness is critical and you may not want to rely on possibly “stale” 
revocation list information.

Searching for Another Person’s Certificate

You may need to search for and download another person’s certificate (for example, if 
you want to send that person an encrypted e-mail). 

Before you can encrypt an e-mail to someone, you must first obtain the receiver’s 
public key (located in the receiver’s certificate) and then follow your application’s 
specific procedure. You can obtain another person’s public key in several ways. For 
example:

• The intended recipient sends the certificate to you.

• You search for the recipient’s certificate in a certificate database and then 
download that certificate.

You can download a certificate that is valid, revoked, expired, or suspended. There are 
various reasons for downloading certificates having a status other than valid. For 
example, downloading a revoked or expired certificate enables you to verify e-mail 
messages or other documents that were signed with the certificate’s private key before 
the certificate was revoked or before it expired.

To search for and download a certificate:

1. Connect to the Enrollment Server.

2. Click End-Entity Certificate Options.
The End-Entity Certificate Search page opens.

3. From the Issuer drop-down list, select the issuer of the person’s certificate.

4. From the drop-down lists in the left column of the table, select one or more 
identifying attributes of the certificate that you want to download. For more 
information on which operator to select, see “Search Filters” on page 25. Select 
and fill in as many attributes as you need in order to narrow your search. 
A table displays all certificates that match your search criteria.

5. To verify that this is the certificate that you want to download, click the View 
Options hyperlink. 
The View and Download Certificate page opens, displaying information about the 
certificate and the certificate itself in PEM-encoded format.

6. Install the certificate or download it in the format that you need. You can also 
download the CA certificate or the CA certificate chain to a file.
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Downloading Revocation Lists

If you want to use the offline method of checking certificate status, you must 
download the revocation lists by saving them to a file.

Note: RSA recommends that VPN clients using SCEP download only revocation lists 
that are issued by a trusted self-signed CA.

To save a revocation list to a file:

1. Connect to the Enrollment Server using a web browser.

2. Click CA Options.
The Signer Options page opens.

3. Under Save the CA’s Revocation List to a file, select the CA whose revocation 
list you want to download from the drop-down list.

4. Select the file format in which you want to save the revocation list. You can save 
the revocation list as either a DER-encoded or PEM of a DER-encoded file.

5. Click one of Save Complete CRL, Save Delta CRL, or Save ARL (the type of 
revocation list you want to save).

6. Specify the location (the drive and directory) where you want to save the 
revocation list and save it.

Note: By default, the filenames provided for a complete CRL are 
pemEncodedCRL.crl and derEncodedCRL.crl. By default, the filenames 
provided for a delta CRL are pemEncodedDeltaCRL.crl and 
derEncodedDeltaCRL.crl. By default, the filenames provided for an ARL are 
pemEncodedARL.crl and derEncodedARL.crl. The filename can be changed 
before or after the file is saved to the specified location.

The revocation list is downloaded and saved to a file.
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Validating Revocation List Information

This section explains how you make sure that the revocation list information you 
receive has not been altered or tampered with. To get this assurance, you must do one 
of the following:

• Download the revocation list signer’s certificate

• Save a copy of the revocation list signer’s certificate to a file and then install it in 
your application

Your application verifies the cryptographic signature on the revocation lists you 
receive with the public key from the revocation list’s signer certificate. If the 
signatures are valid, your application determines that you are receiving a bona fide, 
unaltered revocation list from that signer.

Downloading a Revocation List Signer Certificate to a Browser

If you plan to rely on revocation lists to check the status of the certificates of others, 
you should download the certificate of the issuing authority’s revocation list signer (if 
a designated revocation list signer exists for that authority).

To download a revocation list signer certificate to a browser:

1. Connect to the Enrollment Server using a web browser.

2. Click CA Options.
The Signer Options page opens.

3. Under Install the CA or Revocation List Signer Certificate into a Browser, 
select the CA for which you want to download the revocation list signer 
certificate.

4. Click Install CA’s Revocation List Signer Cert.
If there is no designated revocation list signer, you see an error message that the 
CA signs its own revocation lists and a prompt to install the CA certificate 
instead.

5. If you use Microsoft Internet Explorer:

a. Do one of the following:

• In earlier versions of Internet Explorer, you are prompted to either open 
the file or save it to a disk. Select Open this file from its current 
location and click OK.

• In later versions of Internet Explorer, in the File Download dialog box, 
click Save, then in the Download Complete dialog box, click Open.

Important: If Windows is not properly configured to manage the MIME type 
associated with certificates, the certificate is displayed as a jumble of ASCII 
characters. If this happens, connect to the Enrollment Server, click CA 
Options, and save the CA certificate in DER-encoded format. When 
prompted to open the file or save it to a disk, select Open this file from its 
current location. Then, complete step b and step c of this procedure to 
successfully install the CA certificate into Microsoft Internet Explorer.
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b. In the Certificate window, click Install Certificate.
The Certificate Import Wizard opens.

c. Follow the prompts in the Certificate Import Wizard, selecting Automatically 
select the certificate store based on the type of certificate.

6. If you use Firefox or Mozilla, save the file and import it into your browser.

The revocation list signer certificate is now available for use in applications such as 
web browsers and e-mail clients.

Saving a Revocation List Signer Certificate to a File

To import revocation list signer certificates into one or more non–web browser 
applications (such as a VPN client), you must first save each revocation list signer 
certificate to a file. You can then import it into other PKI-enabled applications.

To save a revocation list signer certificate to a file:

1. Connect to the Enrollment Server using a web browser.

2. Click CA Options.
The Signer Options page opens.

3. Under Save the CA or Revocation List Signer Certificate to a File, select the 
CA for which you want to save the revocation list signer certificate.

4. Select the file format in which you want to save the certificate.

5. Click Save CA’s Revocation List Signer Cert.
If there is no designated revocation list signer, you see an error message that the 
CA signs its own revocation lists and a prompt to install the CA certificate instead.

6. Specify the location (the drive and directory) where you want to save the 
revocation list signer certificate and save it.

Note: By default, the filename provided is the nickname of the revocation list 
signer certificate.

The revocation list signer certificate is downloaded and saved to a file. You can 
import this file into web browsers, e-mail clients, VPN clients, and other 
PKI-enabled applications.

PKCS #7 containing the certificate chain Saves the revocation list signer certificate 
and all certificates from its signature chain 
in PKCS #7 format.

PKCS #7 containing the certificate Saves the revocation list signer certificate 
in PKCS #7 format.

DER-encoded certificate Saves the revocation list signer certificate 
in DER-encoded format.

PEM of DER-encoded certificate Saves the DER-encoded revocation list 
signer certificate in PEM format.
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Viewing Signer Certificates

As part of your process of determining whether to trust a particular certificate, you 
may want to view the information contained within a CA or revocation list signer 
certificate.

To view the information contained within a certificate type:

1. Connect to the Enrollment Server using a web browser.

2. Click CA Options.
The Signer Option page opens.

3. Under Examine a CA Certificate, from the drop-down list, select the CA.

4. Click Examine CA or Examine CA’s revocation list signer.
The information for that certificate is displayed in a new window. If the revocation 
list signer certificate does not exist, you see an error message that the CA signs its 
own revocation lists.
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A Certificate Profiles and Extensions

Certificate Profiles

A certificate profile is a predefined list of mandatory and recommended certificate 
extensions. Profiles allow you to select a group of certificate extensions rather than 
selecting individual extensions. Do not apply profiles unless you have a clear 
understanding of how the extensions contained in the certificate profile work.

The RSA Certificate Manager Profile Editor includes a number of predefined profiles 
with the specified mandatory, forbidden, and recommended extensions. You can 
modify these profiles through the Profile Editor (for example, change the profile 
name, add and remove extensions). For more information, see the 
RSA Certificate Manager Administrator’s Guide. 

Note: The profile names in this section are the installation values.

The following default profiles are defined in RSA Certificate Manager 6.8:

Basic PKIX-Compliant CA Certificate. This profile adds a basic set of 
PKIX-compliant extensions to a CA certificate.

Basic PKIX-Compliant End-Entity Certificate. This profile adds a basic set of 
PKIX-compliant extensions to an end-entity certificate.

Custom CA Certificate. This profile allows a general X.509-compliant CA 
certificate to be issued. 

Custom End-Entity Certificate. This profile allows a general X.509-compliant 
end-entity certificate to be issued.

Delegated OCSP Responder Certificate. This profile defines which extensions 
are mandatory, recommended, or forbidden in certificates issued to OCSP 
responders and revocation list signers that are authorized by the CA. 

EV SSL Root CA. This profile defines the required and forbidden extensions for 
the self-signed certificate issued to the Root CA of the certificate chain under 
which the EV SSL subscriber certificate is issued.

EV SSL Subordinate CA Certificate. This profile defines the required, 
recommended, and forbidden extensions for the certificate issued to the 
subordinate CA in the certificate chain under which the EV SSL subscriber 
certificate is issued.

EV SSL Subscriber Certificate. This profile defines which extensions are 
mandatory, recommended, or forbidden in EV SSL certificates issued to identify 
web sites. 
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MS Domain Controller Certificate. This profile allows Domain Controller 
certificates to be issued by non-Microsoft CAs on Microsoft Windows 2000 
platforms. 

MS Exchange Certificate. This profile allows end-entity certificates to be issued 
for use in encrypting and signing e-mail messages for Microsoft Outlook users.

MS Logon Certificate. This profile allows smart card logon certificates to be 
issued by non-Microsoft CAs on Microsoft Windows 2000 platforms.

MS Machine Certificate. This profile defines which extensions are mandatory or 
forbidden in certificates issued to a machine. 

S/MIME User Certificate. This profile adds a set of extensions to an end-entity 
certificate that will be used with S/MIME applications such as e-mail.

PIV Authentication Certificate Profile. This profile specifies mandatory and 
forbidden extensions in PIV certificates issued for card identification.

PIV Card Authentication Certificate Profile. This profile is used in PIV 
certificates issued on cards used for gaining physical access.

PIV End-Entity Signature Certificate profile. This profile specifies mandatory 
and forbidden extensions in PIV certificates issued to Federal employees and 
contractors, where the public key verifies digital signatures.

PIV Key Management Certificate Profile. This profile specifies mandatory and 
forbidden extensions in PIV certificates issued to Federal employees and 
contractors where the public key is used for key management operations.

Qualified Certificates. This profile allows end-entity certificates with certain 
extensions that conform to the IETF Qualified Certificate Profile (RFC 3039) to 
be issued. The certificate’s primary purpose is to identify a person with a high 
level of assurance in public non-repudiation services.

SEIS Certificate. This profile specifies which extensions are mandatory or are 
not used in the SEIS ID certificate.

SSL Server Certificate. This profile adds a set of extensions to a server 
certificate (an end-entity certificate used by a server) that can be used for server 
authentication during SSL connections.

SSL Client Certificate. This profile adds a set of extensions to an end-entity 
certificate that can be used for client authentication during SSL connections. 

VPN (IPSec) Certificate. This profile adds a set of extensions to an end-entity 
certificate that will be used in Virtual Private Networks (VPNs).

Certificate Extensions

Certificate extensions allow organizations to embed information within a certificate 
beyond what is stored in the standard fields of an X.509 certificate. Extensions can 
either provide information about the subject and/or issuer of a certificate or place 
limitations on the possible uses for a certificate. Do not apply extensions to a 
certificate unless you have a clear understanding of how the extension works and what 
it is intended to accomplish.
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Certificate extensions may be designated as either critical or non-critical. If an 
extension is flagged as critical, it implies that the information contained in the 
extension is too important for a PKI-enabled application to ignore. A PKI-enabled 
application rejects a certificate if it does not know how to correctly process the 
information contained in a critical extension. If an extension is flagged as non-critical, 
a PKI-enabled application can accept a certificate even if it does not know how to 
correctly process the information contained in the extension.

Note: These x.509 certificate extensions are described in the content of the PKIX 
standard, particularly with respect to the critical and non-critical labelling of 
extensions.

Revocation list extensions (extensions that are part of complete CRLs, delta CRLs, 
and ARLs) have properties similar to certificate extensions.

Many standard extensions are defined by the Internet Engineering Task Force (IETF) 
in section 4 of RFC 3280. For more information on the standards, go to 
http://www.ietf.org/.

Some private companies and organizations have also defined their own extensions, 
which are tailored to specific needs. RSA Registration Manager supports Netscape 
extensions, the Secure Electronic Transactions (SET) extensions defined by 
MasterCard/Visa, the Novell extensions, the SEIS extension developed by the 
Swedish Standards Institute (SIS), and the Qualified Certificate Statements as defined 
by RFC 3739 and the European Telecommunications Standards Institute (ETSI).

v3 Certificate Extensions

Registration Manager supports the following v3 certificate extensions:

• “Authority Information Access”

• “Authority Key Identifier”

• “Basic Constraints”

• “Certificate Policies”

• “Certificate Template Name”

• “CRL Distribution Points”

• “Extended Key Usage”

• “Freshest CRL”

• “Issuer Alternative Names”

• “Key Usage”

• “Name Constraints”

• “Netscape Base URL”

• “Netscape CA Policy URL”

• “Netscape CA Revocation URL”

• “Netscape Certificate Renewal URL”

• “Netscape Certificate Type”
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• “Netscape Comment”

• “Netscape Revocation URL”

• “Netscape SSL Server Name”

• “Novell Reliance Limits”

• “PIV NACI”

• “PKIX OCSP No Check”

• “Policy Constraints”

• “Policy Mappings”

• “Private Key Usage Period”

• “Qualified Certificate Statements”

• “SEIS Card Number”

• “SET Card Certificate Required”

• “SET Certificate Type”

• “SET Extensions”

• “SET Merchant Data”

• “SET Tunneling”

• “Subject Alternative Names”

• “Subject Directory Attributes”

• “Subject Key Identifier”

Authority Information Access

This extension indicates how to access CA information and services for the issuer of 
the certificate. Information and services may include CA policy data. This information 
can be included in end-entity or CA certificates, and it must be flagged as non-critical. 
Registration Manager fully supports this extension.

ASN.1 Representation
id-pe-authorityInfoAccess OBJECT IDENTIFIER ::= { id-pe 1 }
AuthorityInfoAccessSyntax  ::=  SEQUENCE SIZE (1..MAX) OF 
AccessDescription
AccessDescription  ::=  SEQUENCE {
         accessMethod          OBJECT IDENTIFIER,
         accessLocation        GeneralName  }
id-ad OBJECT IDENTIFIER ::= { id-pkix 48 }
id-ad-caIssuers OBJECT IDENTIFIER ::= { id-ad 2 }
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Authority Key Identifier

This extension provides a means of identifying the public key corresponding to the 
private key used to sign a certificate. This extension is used when an issuing CA has 
multiple signing keys. The information in this extension is based on either the subject 
key identifier in the issuer’s certificate or the issuer name field and serial number in 
the issuer’s certificate. The keyIdentifier field of the authorityKeyIdentifier extension 
should be included in all certificates generated by conforming CAs to facilitate chain 
building. There is one exception; where a CA distributes its public key in the form of a 
“self-signed” certificate, the authority key identifier may be omitted, because the 
subject and authority key identifiers would be identical.  Registration Manager Vettors 
can configure this extension. Registration Manager fully supports this extension.

ASN.1 Representation
id-ce-authorityKeyIdentifier OBJECT IDENTIFIER ::=  { id-ce 35 }
AuthorityKeyIdentifier ::= SEQUENCE {
    keyIdentifier             [0] KeyIdentifier           OPTIONAL,
    authorityCertIssuer       [1] GeneralNames            OPTIONAL,
    authorityCertSerialNumber [2] CertificateSerialNumber OPTIONAL  
}
KeyIdentifier ::= OCTET STRING

Basic Constraints

This extension indicates whether or not the certificate is a CA certificate. It also 
specifies how deep the certification path can be through that CA. This extension must 
be flagged as critical in CA certificates. It is not necessary for non-CA certificates to 
include this extension; if they do, the cA attribute must be FALSE. If the CA flag is set 
to true, pathLenConstraint gives the maximum number of CA certificates that may 
follow this certificate in a certification path. Registration Manager does not use the 
pathLenConstraint attribute; otherwise Registration Manager fully supports this 
extension.

ASN.1 Representation
id-ce-basicConstraints OBJECT IDENTIFIER ::=  { id-ce 19 }
BasicConstraints ::= SEQUENCE {
     cA                      BOOLEAN DEFAULT FALSE,
     pathLenConstraint       INTEGER (0..MAX) OPTIONAL }

Certificate Policies

This extension is used to identify the policies that were followed when creating the 
certificate. It may also identify the purposes for which the certificate may be used. It is 
recommended that policy information terms consist of only an OID. This extension 
can be flagged as either critical or non-critical. Registration Manager fully supports 
this extension with the exception of DisplayText, which is hard coded as BMPString 
for non-ASCII characters.

A common use of this extension is to indicate the URI from which a copy of the CA’s 
Certification Practice Statement (CPS) can be retrieved. It is a complex extension and 
you should consult more detailed documentation if you intend to use it.
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ASN.1 Representation
id-ce-certificatePolicies OBJECT IDENTIFIER ::=  { id-ce 32 }
certificatePolicies ::= SEQUENCE SIZE (1..MAX) OF 

PolicyInformation
PolicyInformation ::= SEQUENCE {
      policyIdentifier   CertPolicyId,
      policyQualifiers   SEQUENCE SIZE (1..MAX) OF
                              PolicyQualifierInfo OPTIONAL }
CertPolicyId ::= OBJECT IDENTIFIER
PolicyQualifierInfo ::= SEQUENCE {
      policyQualifierId  PolicyQualifierId,
      qualifier          ANY DEFINED BY policyQualifierId }
-- policyQualifierIds for Internet policy qualifiers
id-qt          OBJECT IDENTIFIER ::=  { id-pkix 2 }
id-qt-cps      OBJECT IDENTIFIER ::=  { id-qt 1 }
id-qt-unotice  OBJECT IDENTIFIER ::=  { id-qt 2 }
PolicyQualifierId ::= OBJECT IDENTIFIER ( id-qt-cps | id-qt-unotice 
)
Qualifier ::= CHOICE {
      cPSuri           CPSuri,
      userNotice       UserNotice }
CPSuri ::= IA5String
UserNotice ::= SEQUENCE {
      noticeRef        NoticeReference OPTIONAL,
      explicitText     DisplayText OPTIONAL}
NoticeReference ::= SEQUENCE {
      organization     DisplayText,
      noticeNumbers    SEQUENCE OF INTEGER }
DisplayText ::= CHOICE {
      visibleString    VisibleString  (SIZE (1..200)),
      bmpString        BMPString      (SIZE (1..200)),
      utf8String       UTF8String     (SIZE (1..200)) }

Certificate Template Name

This extension is used in the process of enabling smart card logon with Microsoft 
Windows and a non-Microsoft Certificate Authority (CA) such as Certificate 
Manager. This process requires a Certificate Manager end-entity certificate on a smart 
card and, optionally, a Certificate Manager end-entity certificate for the Active 
Directory Domain Controller. The latter certificate must contain a Certificate 
Template Name extension. This extension can be flagged as either critical or 
non-critical. Registration Manager fully supports this extension.

The object type of this extension is a BMPString and its value must be 
‘DomainController’ for Domain Controller certificates.

ASN.1 Representation
id-CertTemplateName OBJECT IDENTIFIER ::=  { 1 3 6 1 4 1 
311 20 2 }

CertTemplateName ::= SEQUENCE {
oid { id-CertTemplateName }
name BMPString }
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CRL Distribution Points

This extension identifies how CRL information for the certificate carrying this 
extension can be obtained by the users of a PKI. This extension should be flagged as 
non-critical. Registration Manager fully supports this extension.

ASN.1 Representation
id-ce-cRLDistributionPoints OBJECT IDENTIFIER ::=  { id-ce 31 }
CRLDistributionPoints ::= {
      CRLDistPointsSyntax }
CRLDistPointsSyntax ::= SEQUENCE SIZE (1..MAX) OF DistributionPoint
DistributionPoint ::= SEQUENCE {
      distributionPoint       [0]     DistributionPointName 
OPTIONAL,
      reasons                [1]     ReasonFlags OPTIONAL,
      cRLIssuer               [2]     GeneralNames OPTIONAL }
DistributionPointName ::= CHOICE {
      fullName                 [0]     GeneralNames,
      nameRelativeToCRLIssuer  [1]    
 RelativeDistinguishedName }
ReasonFlags ::= BIT STRING {
      unused                  (0),
      keyCompromise           (1),
      cACompromise            (2),
      affiliationChanged      (3),
      superseded              (4),
      cessationOfOperation    (5),
      certificateHold          (6) }

Extended Key Usage

This extension identifies purposes for which a certificate’s public key may be used. 
Basic key uses are identified in the Key Usage certificate extension. Object identifiers 
used to identify key purposes shall be assigned in accordance with IANA or ITU-T 
Rec. X.660 | ISO/IEC/ITU 9834-1. RFC 3280 Section 4.2.1.13 includes a list of key 
usage identifiers and their OIDs.

This extension can be flagged as either critical or non-critical. If the extension is 
flagged critical, then the certificate must be used only for one of the purposes 
indicated. If the extension is flagged non-critical, then it indicates the intended 
purpose or purposes of the key, and may be used in finding the correct key/certificate 
of an entity that has multiple keys/certificates. It is an advisory field and does not 
imply that usage of the key is restricted by the CA to the purpose indicated. 
Applications using the certificate may nevertheless require that a particular purpose be 
indicated in order for the certificate to be acceptable to that application. 
Registration Manager fully supports this extension.

ASN.1 Representation
id-ce-extKeyUsage OBJECT IDENTIFIER ::= {id-ce 37}
ExtKeyUsageSyntax ::= SEQUENCE SIZE (1..MAX) OF KeyPurposeId
KeyPurposeId ::= OBJECT IDENTIFIER
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Freshest CRL

This extension identifies how delta CRL information for the certificate carrying this 
extension can be obtained by the users of a PKI. It is also known as the Delta CRL 
Distribution Points extension. This extension should be flagged as non-critical. 
Registration Manager fully supports this extension.

ASN.1 Representation
id-ce-freshestCRL OBJECT IDENTIFIER ::=  { id-ce 46 }
FreshestCRL ::= CRLDistributionPoints

Issuer Alternative Names

This extension allows a certificate issuer (such as a CA) to be identified by an 
alternative name. Acceptable alternative names include e-mail addresses, DNS 
hostnames, IP addresses, and URIs. This extension should be flagged as non-critical if 
present. Registration Manager fully supports this extension.

ASN.1 Representation
id-ce-issuerAltName OBJECT IDENTIFIER ::=  { id-ce 18 }
IssuerAltName ::= GeneralNames

Key Usage

This extension identifies purposes for which a certificate’s public key may be used 
(for example, digital signatures, encryption). The usage restriction may be employed 
when a key that could be used for more than one operation is to be restricted. For 
example, when an RSA key should be used only for signing, the digitalSignature 
and/or nonRepudiation bits would be asserted. Likewise, when an RSA key should be 
used only for key management, the keyEncipherment bit would be asserted. This 
extension should be flagged as critical when used. Registration Manager fully 
supports this extension.

ASN.1 Representation
id-ce-keyUsage OBJECT IDENTIFIER ::=  { id-ce 15 }
KeyUsage ::= BIT STRING {
      digitalSignature        (0),
      nonRepudiation          (1),
      keyEncipherment         (2),
      dataEncipherment        (3),
      keyAgreement            (4),
      keyCertSign             (5),
      cRLSign                 (6),
      encipherOnly            (7),
      decipherOnly             (8) }
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Name Constraints

This extension should only appear in CA certificates. It identifies a range of 
acceptable subject names that may appear in certificates in a CA’s certification path. 
Name Constraints may apply to the Subject DN or subject alternative name in 
certificates the CA issues. For example, a name constraint for e-mail addresses may 
indicate that all e-mail addresses on the host xyz.com are accepted. This extension 
should be flagged as critical when present. Registration Manager uses this extension 
with cross-certificates. Registration Manager fully supports this extension.

ASN.1 Representation
id-ce-nameConstraints OBJECT IDENTIFIER ::= { id-ce 30 } 
NameConstraints ::= SEQUENCE { 

permittedSubtrees [0] GeneralSubtrees OPTIONAL, 
excludedSubtrees [1] GeneralSubtrees OPTIONAL }

 
GeneralSubtrees ::= SEQUENCE SIZE (1..MAX) OF GeneralSubtree
 
GeneralSubtree ::= SEQUENCE { 

base GeneralName, 
minimum [0] BaseDistance DEFAULT 0, 
maximum [1] BaseDistance OPTIONAL } 

BaseDistance ::= INTEGER (0..MAX) 

Netscape Base URL

This extension contains a base URL which is added to the beginning of all URLs in a 
certificate. This extension must be flagged as non-critical. Registration Manager fully 
supports this extension.

ASN.1 Representation
IA5String

Netscape CA Policy URL

This extension contains the relative or absolute URL of a web page identifying the 
policies that were followed when creating the certificate and the purposes for which 
the certificate may be used. This extension must be flagged as non-critical. 
Registration Manager fully supports this extension.

ASN.1 Representation
IA5String

Netscape CA Revocation URL

This extension contains a relative or absolute URL that can be used to check the status 
of any certificates signed by the CA. This extension must be flagged as non-critical, 
and should only appear in CA certificates. Registration Manager fully supports this 
extension.

ASN.1 Representation
IA5String
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Netscape Certificate Renewal URL

This extension contains the relative or absolute URL of a web page containing a 
certificate renewal form. The certificate serial number is concatenated to the URL in 
use. Refer to Netscape documentation if you want to use this extension. This extension 
must be flagged as non-critical. Registration Manager fully supports this extension.

ASN.1 Representation
IA5String

Netscape Certificate Type

This extension identifies restrictions on the use of the certificate. If present, the 
certificate should only be used for the purposes identified in the extension, but this is 
not strictly enforced, even by Netscape Communicator. If not present, the certificate 
can be used for all purposes except certificate signing. This extension should be 
flagged as non-critical. Registration Manager fully supports this extension.

ASN.1 Representation
BITSTRING {
     sslClient        (0),
     sslServer        (1),
     smime            (2),
     objectSigning    (3),
     reserved         (4),
     sslCA            (5),
     smimeCA          (6),
     objectSigningCA  (7)   }

Netscape Comment

This extension contains comments that may be displayed to the user when the 
certificate is viewed. This extension should be flagged as non-critical. 
Registration Manager fully supports this extension.

ASN.1 Representation
IA5String

Netscape Revocation URL

This extension contains a URL that can be used to check the status of the certificate. 
As with the Netscape Certificate Renewal URL extension, the Revocation URL is 
concatenated with the certificate serial number in use. You should refer to additional 
Netscape documentation if you want to use this extension. This extension must be 
flagged as non-critical. Registration Manager fully supports this extension.

ASN.1 Representation
IA5String
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Netscape SSL Server Name

This extension contains the hostname of the SSL server using the certificate. If the 
hostname identified in the extension does not match the hostname of the server 
presenting the certificate, the user can terminate the SSL connection to the server. This 
extension should be flagged as non-critical. Registration Manager fully supports this 
extension.

ASN.1 Representation
IA5String

Novell Reliance Limits

This extension, developed by Novell, provides a mechanism for specifying the 
monetary amount per transaction and as a sum of transactions with a single entity that 
a certificate’s entity is authorized to spend. Registration Manager fully supports this 
extension.

ASN.1 Representation
relianceLimits EXTENSION ::= { SYNTAX RelianceLimits IDENTIFIED BY 
{pa-rl) }
-- 2.16.840.113719.1.9.4.2
RelianceLimits ::= SEQUENCE {
  perTransactionLimit MonetaryValue,
  perCertificateLimit MonetaryValue 
}

MonetaryValue ::= SEQUENCE { -- from SET and draft ANSI X9.45
  currency Currency,
  amount INTEGER,
  amtExp10 INTEGER
}

-- value is amount * (10** amtExp1), an exact representation
Currency ::= INTEGER (1..999)
-- currency denomination from ISO 4217
-- cf. Appendix E for the numeric currency codes and their
-- alphabetic (display) equivalents.
-- US Dollar (USD) is 840.
-- Euro (EUR) is 978.
A: Certificate Profiles and Extensions 109



RSA Registration Manager 6.9 Vettor’s Guide
PIV NACI

The Personal Identity Verification National Agency Check with Inquiries (PIV NACI) 
extension indicates whether an individual’s background check is either successfully 
completed or initiated but not successfully completed at the time the card is issued. 
This extension must appear in PIV authentication certificates.

A value of True indicates that the FBI National Criminal History Fingerprint Check 
has been successfully completed and a NACI has been initiated but is not complete. A 
value of False indicates that the NACI has been completed and successfully 
adjudicated. This extension should be flagged as non-critical. Registration Manager 
fully supports this extension.

ASN.1 Representation
pivNACI EXTENSION ::= {
SYNTAX BOOLEAN
IDENTIFIED BY id-piv-NACI
}

PKIX OCSP No Check

A CA may specify that an OCSP client can trust a responder for the lifetime of the 
responder’s certificate. The CA does so by including this extension in an OCSP 
responder certificate. The value of the extension should be NULL. CAs issuing such a 
certificate should realize that a compromise of the responder’s key is as serious as the 
compromise of a CA key used to sign CRLs, at least for the validity period of this 
certificate. CAs may choose to issue this type of certificate with a very short lifetime 
and renew it frequently. This extension should be flagged as non-critical. 
Registration Manager fully supports this extension.

ASN.1 Representation
OCSPNoCheck ::= NULL

Policy Constraints

This extension can be used to constrain certification path validation. This extension 
can be used to prohibit policy mapping. It may also be used to identify the certificate 
policies required by the subject CA, or to identify policies that are required by both the 
subject CA and the CA that issued the certificate. If this extension is present, it should 
not be a null sequence—at least one of the fields should be present. This extension can 
be flagged as either critical or non-critical. Registration Manager fully supports this 
extension.

ASN.1 Representation
id-ce-policyConstraints OBJECT IDENTIFIER ::=  { id-ce 36 }
PolicyConstraints ::= SEQUENCE {
      requireExplicitPolicy           [0] SkipCerts OPTIONAL,
      inhibitPolicyMapping            [1] SkipCerts OPTIONAL }
SkipCerts ::= INTEGER (0..MAX)
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Policy Mappings

This extension identifies which certification policies are to be considered as 
comparable between both the subject CA and the CA that issued the certificate. This 
extension must be flagged as non-critical, and should only appear in CA certificates. 
Registration Manager fully supports this extension.

ASN.1 Representation
id-ce-policyMappings OBJECT IDENTIFIER ::=  { id-ce 33 }
PolicyMappings ::= SEQUENCE SIZE (1..MAX) OF SEQUENCE {
      issuerDomainPolicy      CertPolicyId,
      subjectDomainPolicy     CertPolicyId }

Private Key Usage Period

This extension allows the certificate issuer to specify a different validity period for the 
private key than the certificate. This extension is intended for use with digital 
signature keys. This extension must be flagged as non-critical. Registration Manager 
fully supports this extension.

ASN.1 Representation
id-ce-privateKeyUsagePeriod OBJECT IDENTIFIER ::= { id-ce 16 }
PrivateKeyUsagePeriod ::= SEQUENCE {
        notBefore       [0]     GeneralizedTime OPTIONAL,
        notAfter        [1]     GeneralizedTime OPTIONAL }

Qualified Certificate Statements

The Qualified Statements allows for the inclusion of defined statements related to 
Qualified Certificates. These statements, selected by the certificate issuer, are an 
indication that the certificate is issued as a Qualified Certificate in accordance with a 
particular legal system detailed in the statement. This extension may be flagged as 
critical or non-critical. Certificate Manager supports the following statements:

• id-etsi-qcs-QcCompliance (OID: 0.4.0.1862.1.1)

• id-etsi-qcs-QcLimitValue (OID: 0.4.0.1862.1.2)

• id-etsi-qcs-QcRetentionPeriod (OID: 0.4.0.1862.1.3)

• id-etsi-qcs-QcSSCD (OID: 0.4.0.1862.1.4)

• id-qcs-pkixQCSyntax-v1 (OID: 1.3.6.1.5.5.7.11.1)

• id-qcs-pkixQCSyntax-v2 (OID: 1.3.6.1.5.5.7.11.2)

• 2.16.792.1.61.0.1.5070.1.1 (OID: 2.16.792.1.61.0.1.5070.1.1)

For more information on the Qualified Certificate Statements extension, go to 
http://www.etsi.org/.
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ASN.1 Representation

Note: This section does not contain the ASN.1 representation of OID 
2.16.792.1.61.0.1.5070.1.1. For information, in Turkish, on this statement, see 
http://www.tk.gov.tr/Duzenlemeler/Hukuki/kurulkararlari/kkararlari/ek_profil_
rehberi.pdf.

-- ASN.1 declaration for 6 QC statements QC-STATEMENT, 
qcStatement-1

FROM PKIXqualified93 {iso(1) identified-organization(3) dod(6) 
internet(1) security(5) mechanisms(5) pkix(7) id-mod(0) 
id-mod-qualified-cert-93(11)};

-- statements esi4-qcStatement-1 QC-STATEMENT ::= { IDENTIFIED BY 
-- id-etsi-qcs-QcCompliance } This statement is a statement by the 
issuer -- that this certificate is issued as a Qualified 
Certificate according 
-- Annex I and II of the Directive 1999/93/EC of the European 
Parliament
-- and of the Council of 13 December 1999 on a Community framework 
for
-- electronic signatures, as implemented in the law of the country 
-- specified in the issuer field of this certificate.

esi4-qcStatement-2 QC-STATEMENT ::= { SYNTAX QcEuLimitValue 
IDENTIFIED BY id-etsi-qcs-QcLimitValue }

-- This statement is a statement by the issuer which impose a 
limitation on
-- the value of transaction for which this certificate can be used 
to the
-- specified amount (MonetaryValue), according to the Directive 
1999/93/EC
-- of the European Parliament and of the Council of 13 December 
1999 on a
-- Community framework for electronic signatures, as implemented in 
the
-- law of the country specified in the issuer field of this 
certificate.
        
QcEuLimitValue ::= MonetaryValue
MonetaryValue::= SEQUENCE {
currency Iso4217CurrencyCode,
amount INTEGER,
exponent INTEGER}

-- value = amount * 10^exponent
Iso4217CurrencyCode ::= CHOICE {
alphabetic PrintableString (SIZE 3), 

-- Recommended numeric INTEGER (1..999) }
-- Alphabetic or numeric currency code as defined in ISO 4217 
-- It is recommended that the Alphabetic form is used
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esi4-qcStatement-3 QC-STATEMENT ::= { SYNTAX QcEuRetentionPeriod
IDENTIFIED BY id-etsi-qcs-QcRetentionPeriod }

-- This statement is a statement by which the issuer guarantees 
that for
-- the certificate where this extension appears that the 
information
-- received from the subscriber at the time of registration will be
-- archived and can be made available upon request beyond the end of 
the
-- validity period of the certificate for the number of years as 
indicated -- in this statement.
    
QcEuRetentionPeriod ::= INTEGER

esi4-qcStatement-4 QC-STATEMENT ::= { SYNTAX QcSSCD IDENTIFIED BY 
id-etsi-qcs-QcSSCD }

-- This statement is a statement by which the issuer claims that for 
the
-- certificate where this statement appears that the private key
-- associated with the public key in the certificate is protected 
-- according to Annex III of the Directive 1999/93/EC of the 
European
-- Parliament and of the Council of 13 December 1999 on a Community 
-- framework for electronic signatures.

qcStatement-1 QC-STATEMENT ::= { SYNTAX SemanticsInformation 
IDENTIFIED BY id-qcs-pkixQCSyntax-v1 }

-- This statement identifies conformance with requirements defined 
in RFC -- 3739 (Version 1). This statement may optionally contain 
additional 
-- semantics information as specified below.

qcStatement-2 QC-STATEMENT ::= { SYNTAX SemanticsInformation 
IDENTIFIED BY id-qcs-pkixQCSyntax-v2 }

-- This statement identifies conformance with requirements defined 
in this
-- Qualified Certificate profile (Version 2). This statement may
-- optionally contain additional semantics information as specified 
below.

    SemanticsInformation ::= SEQUENCE {
      semanticsIdentifier        OBJECT IDENTIFIER   OPTIONAL,
      nameRegistrationAuthorities NameRegistrationAuthorities
                                                      OPTIONAL }
      (WITH COMPONENTS {..., semanticsIdentifier PRESENT}|
       WITH COMPONENTS {..., nameRegistrationAuthorities PRESENT})

    NameRegistrationAuthorities ::=  SEQUENCE SIZE (1..MAX) OF
      GeneralName

-- object identifiers
id-etsi-qcs OBJECT IDENTIFIER ::= { itu-t(0) 
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identified-organization(4) etsi(0) id-qc-profile(1862) 1 }
id-etsi-qcs-QcCompliance OBJECT IDENTIFIER ::= { id-etsi-qcs 1 }
id-etsi-qcs-QcLimitValue OBJECT IDENTIFIER ::= { id-etsi-qcs 2 }
id-etsi-qcs-QcRetentionPeriod OBJECT IDENTIFIER ::= { id-etsi-qcs 3 
}
id-etsi-qcs-QcSSCD OBJECT IDENTIFIER ::= { id-etsi-qcs 4 }

-- supported statements
SupportedStatements QC-STATEMENT ::= { qcStatement-1 |
esi4-qcStatement-1 | esi4-qcStatement-2 | esi4-qcStatement-3 |
esi4-qcStatement-4, qcStatement-1, qcStatement-2...}

SEIS Card Number

This extension is used in conjunction with certain certificate DN attributes (Surname, 
GivenName, and SerialNumber) in the creation of the SEIS Electronic ID certificate, 
which was developed by the Swedish Standards Institute. This extension can be 
flagged as critical or non-critical. Registration Manager fully supports this extension. 

ASN.1 Representation
id-ce-seisCardNumber OBJECT IDENTIFIER ::= { id-seis-pe 1 }
SeisCardNumber ::= SEQUENCE {
    cardNumber         [0]    }

SET Card Certificate Required

This extension indicates whether the payment gateway supports online transactions 
with credit card holders who do not have a certificate. This extension must be flagged 
as non-critical. Registration Manager fully supports this extension.

ASN.1 Representation
cardCertRequired EXTENSION ::= {
  SYNTAX BOOLEAN
  IDENTIFIED BY id-set-cardCertRequired
}

SET Certificate Type

This extension identifies the entity that is using the certificate (for example, credit 
card holders, merchants, the payment gateway, or CAs). This extension must be 
flagged as critical, and should appear in every SET certificate. Registration Manager 
fully supports this extension.

ASN.1 Representation
certificateType EXTENSION ::= {
  SYNTAX CertificateTypeSyntax
  CRITICAL TRUE
  IDENTIFIED BY id-set-certificateType
}
CertificateTypeSyntax ::= BIT STRING {
  card (0),
  mer  (1),
  pgwy (2),
  cca  (3),
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  mca  (4),
  pca  (5),
  gca  (6),
  bca  (7),
  rca  (8),
  acq  (9)
}

SET Extensions

This extension identifies payment instruction SET extensions that the payment 
gateway supports. Credit card holders can only use the payment instruction SET 
extensions supported by the payment gateway. This extension must be flagged as 
non-critical. Registration Manager fully supports this extension.

ASN.1 Representation
setExtensions EXTENSION ::= {
  SYNTAX SETExtensionsSyntax
  IDENTIFIED BY id-set-setExtensions
}
SETExtensionsSyntax ::= SEQUENCE OF OBJECT IDENTIFIER

SET Merchant Data

This extension contains information about a merchant. This information is used by the 
payment gateway when processing online transactions. This extension must be 
flagged as non-critical. Registration Manager fully supports this extension.

ASN.1 Representation
MerchData ::= SEQUENCE {
  merchCatCode MerchCatCode OPTIONAL,
  merchGroup MerchGroup OPTIONAL
}

MerchCatCode ::= NumericString (SIZE(ub-merType)) -- ANSI X9.10
-- Merchant Category Code (MCCs) are assigned by acquirer to
-- describe the merchant's product, service or type of business

MerchGroup ::= ENUMERATED {
  commercialTravel (1),
  lodging          (2),
  automobileRental (3),
  restaurant       (4),
  medical          (5),
  mailOrPhoneOrder (6),
  riskyPurchase    (7),
  other            (8)
}
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SET Tunneling

This extension indicates whether tunneling is possible between a CA or payment 
gateway and the credit card holder. If the CA or payment gateway supports tunneling, 
this extension identifies symmetric key encryption algorithms that can be used. This 
extension must be flagged as non-critical. Registration Manager fully supports this 
extension.

ASN.1 Representation
tunneling EXTENSION ::= {
  SYNTAX TunnelingSyntax
  IDENTIFIED BY id-set-tunneling
}
TunnelingSyntax ::= SEQUENCE {
  tunneling BOOLEAN DEFAULT TRUE,
  tunnelAlgIDs TunnelAlg
}
TunnelAlg ::= SEQUENCE OF OBJECT IDENTIFIER

Subject Alternative Names

This extension allows the certificate subject (such as the entity identified in the 
certificate) to be identified by an alternative name. All parts of the subject alternative 
name must be verified by the CA as the subject alternative name is considered to be 
definitively bound to the public key. Acceptable alternative names include e-mail 
addresses, DNS hostnames, IP addresses, and URIs. Multiple name forms and 
multiple instances of each name form may be included. Whenever such identities are 
bound to a certificate, this extension must be used. Subject Alternative Name is the 
preferred location to include the subject’s e-mail address in a certificate intended for 
e-mail signing or encryption. Registration Manager fully supports this extension.

ASN.1 Representation
id-ce-subjectAltName OBJECT IDENTIFIER ::=  { id-ce 17 }
SubjectAltName ::= GeneralNames
GeneralNames ::= SEQUENCE SIZE (1..MAX) OF GeneralName
GeneralName ::= CHOICE {
       otherName                       [0]     OtherName,
       rfc822Name                      [1]     IA5String,
       dNSName                         [2]     IA5String,
       x400Address                     [3]     ORAddress,
       directoryName                   [4]     Name,
       ediPartyName                    [5]     EDIPartyName,
       uniformResourceIdentifier       [6]     IA5String,
      iPAddress                      [7]    OCTET STRING,
       registeredID                    [8]     OBJECT IDENTIFIER}
OtherName ::= SEQUENCE {
       type-id    OBJECT IDENTIFIER,
       value      [0] EXPLICIT ANY DEFINED BY type-id }
EDIPartyName ::= SEQUENCE {
       nameAssigner            [0]     DirectoryString OPTIONAL,
      partyName               [1]     DirectoryString }
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Subject Directory Attributes

This extension contains information about the certificate subject (such as the entity 
identified in the certificate) that can be stored in a directory. This extension must be 
flagged as non-critical. Registration Manager fully supports this extension.

ASN.1 Representation
id-ce-subjectDirectoryAttributes OBJECT IDENTIFIER ::=  { id-ce 9 }
SubjectDirectoryAttributes ::= SEQUENCE SIZE (1..MAX) OF Attribute
Attribute ::= SEQUENCE {
  type AttributeType,
  values  SET OF AttributeValue
  -- at least one value is required -- }

AttributeType ::= OBJECT IDENTIFIER

AttributeValue ::= ANY

Subject Key Identifier

This extension is used to identify a particular certificate and public key. If an 
end-entity possesses several certificates, this extension can be used to quickly identify 
a particular certificate by its public key. For CA certificates, subject key identifiers 
should be derived from the public key or a method that generates unique values. For 
end-entity certificates, subject key identifiers should be derived from the public key. 
RFC 3280 specifies that the SHA-1 hash of the subject public key bitstring (excluding 
tag and length) be used. To facilitate chain building, this extension should appear in all 
CA certificates, including the Basic Constraints extension where the value of cA is 
True. The value of the subject key identifier must be the value placed in the key 
identifier field of the Authority Key Identifier extension of certificates issued by the 
subject of this certificate. This extension should be flagged as non-critical. 
Registration Manager fills in this extension. Registration Manager fully supports this 
extension.

ASN.1 Representation
id-ce-subjectKeyIdentifier OBJECT IDENTIFIER ::=  { id-ce 14 }
SubjectKeyIdentifier ::= KeyIdentifier
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Glossary

Abstract Syntax Notation One (ASN.1)
Abstract Syntax Notation One (ASN.1) is an International Standards Organization 
(ISO) standard notation for defining the syntax of information data. It defines a 
number of simple data types and specifies a notation for referencing these types and 
for specifying values of these types.

ActiveX Control
ActiveX control is a software component that may be downloaded and installed 
automatically through a web browser, allowing web pages to utilize capabilities of the 
Windows operating system that they would ordinarily not have access to. ActiveX 
controls are typically signed with a digital certificate, allowing users to confidently 
establish the origin of the software before deciding to trust it.

Access Control Lists (ACL)
ACLs control who can access different parts of a system. In the RSA Digital 
Certificate Solution product suite, ACLs are used primarily to control who has access 
to files and directories on a web server.

Administration Server
A virtual web server that is a component of the RSA Certificate Manager and 
RSA Registration Manager Web Servers. The Administration Server is used by 
Administrators to manage Certificate Manager or Registration Manager via a web 
interface. The Administration Server requires client authentication. It also 
communicates securely with the Secure Directory Server.

Administrative CA
A CA created during RSA Certificate Manager installation. This CA signs the 
end-entity certificates for all RSA Certificate Manager Administrators, Vettors, and 
Auditors.

Administrative Certificate
An end-entity certificate issued to one of three Administrative types: Administrator, 
Vettor, and Auditor. RSA Certificate Manager Administrative certificates are signed 
by the Administrative CA; RSA Registration Manager Administrative certificates are 
signed by the CA of the Registration Manager initial target Jurisdiction.

Administrator
A person, possibly with an end-entity certificate, who has access to certain 
administration features through the Administration Server, which may include the CA 
Operations, Administrator Operations, and System Configuration Workbenches. 
Administrator tasks may include planning the PKI implementation, installing 
components of the RSA Digital Certificate Solution product suite, performing initial 
configuration, and managing the daily administration tasks.
The RSA Certificate Manager Administrator certificate is signed by the 
Administrative CA; the RSA Registration Manager Administrator certificate is signed 
by the CA of the Registration Manager initial target Jurisdiction.

Anonymity
The ability of participating entities to use public keys while revealing only that 
information that is pertinent to the situation.
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ARL
See Authority Revocation Lists.

ASN.1
See Abstract Syntax Notation One.

Attribute Certificate
A certificate that emphasizes the holder’s access rights and constraints. This is in 
contrast to identity certificates, which bind a distinguished name (DN) and a public 
key. Commonly, attribute certificates are issued with short validity periods and do not 
contain a public key value.

Auditor
A person with an end-entity certificate who has access to the auditor features on the 
Administration Server. Auditor tasks include viewing and managing the audit logs.
The RSA Certificate Manager Auditor certificate is signed by the Administrative CA; 
the RSA Registration Manager Auditor certificate is signed by the CA of the 
Registration Manager initial target Jurisdiction.

Audit Log
An XML-encoded tamper-resistant file generated by the Logging Server that details 
the success or failure of all PKI operations for which logging has been configured.

Authentication
Certificates are used to identify the author of a message or entity, such as a web server 
or client. People or applications who receive a certificate can verify the identity of the 
certificate owner and the validity of the certificate. This process is called 
authentication.

Authority Revocation List (ARL)
A list of CA certificates that have been revoked or suspended by a particular CA. You 
can use ARLs to check the status of CA certificates offline.

CA
See Certificate Authority.

CA Certificate
A certificate that identifies a CA. When a CA issues a certificate to a client, a server, 
or other entity, the CA private key signs the certificate. You can verify the signature 
using the public key in the CA certificate. See also root CA.

Certificate
Certificates verify the identity of an individual, organization, web server, or hardware 
device. They also ensure non-repudiation in business transactions, as well as to enable 
confidentiality through the use of public-key encryption. PKI uses three main kinds of 
certificates: CA certificates, server certificates (also referred to as SSL certificates), 
and end-entity certificates.

Certificate Authority (CA)
An entity that issues and manages certificates within a PKI. You create and manage 
CAs using a CA software application, such as RSA Certificate Manager.

Certificate Extension
See X.509 v3 Certificate Extension.
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Certificate Fingerprint
The MD5 of a DER-encoded certificate used to identify a certificate when setting 
LDAP and web server ACL rules.

Certificate ID
A certificate identifier used by RSA Certificate Manager to search for or label a 
certificate in the Secure Directory.

Certificate Management Protocol (CMP)
CMP (RFC 2510) is an Internet standard certificate management protocol that defines 
message syntax and semantics supporting many aspects of certificate creation and 
management. This includes registration, revocation, key update, key recovery, 
cross-certification, and many other features. This protocol provides an alternative to 
web-based certificate enrollment.

Certificate Policy (CP)
The conditions and limitations for the use of a digital certificate.

Certificate Profile
A set of extensions along with rules, constraints, and default values for the fields of 
the associated extensions. They are used in the vetting process, as well as to constrain 
and/or validate the information being entered into the certificate extensions.

Certificate Request Syntax (CRS)
CRS, Internet PKI Certificate Request Syntax, specifies an interface to public-key 
certification products and services based on PKCS #7 and PKCS #10. A small number 
of additional services are defined to supplement the core certificate request service. 
Current industry practice regarding the use of PKCS #7 and PKCS #10 is also 
documented for the benefit of the Internet community. In general, the use of PKCS #7 
in CRS is aligned to the Cryptographic Message Syntax (CMS) (RFC 2630), which 
provides a superset of the PKCS #7 syntax.
The above definition and further information is available at 
www.ietf.org/proceedings/98aug/I-D/draft-ietf-smime-crs-00.txt.

Certificate Revocation List (CRL)
A list of revoked and suspended certificates (CA or end-entity) for a particular CA. 
You can use CRLs to check the status of certificates offline. See also Complete CRL 
and Delta CRL.

Certification Practice Statement (CPS)
A CPS defines an organization’s security policies for the issuance and management of 
certificates.

Client Certificate
See End-Entity Certificate.

Complete CRL
A list that contains the serial numbers of certificates that a CA has revoked or 
suspended.

CRL
See Certificate Revocation List.
Glossary 121

http://www.ietf.org/proceedings/98aug/I-D/draft-ietf-smime-crs-00.txt


RSA Registration Manager 6.9 Vettor’s Guide
CRL Server
A virtual web server host that is a component of the RSA Certificate Manager Web 
Server. The CRL Server is used by Certificate Manager as a publishing site for CRLs 
and ARLs for HTTP-based CRL and ARL retrieval respectively. It is not 
SSL-enabled.

Cross-Certificate
A certificate issued by one CA to another CA that allows users to determine the 
trustworthiness of certificates issued by the other CA. 

Cryptographic Provider
The library the RSA Digital Certificate Solution product uses for private-key 
cryptographic operations (such as key pair generation and digital signatures). The 
method is either software-based or hardware-based.

Data Encryption Standard (DES)
A National Institute of Standards & Technology (NIST) standard for secret key 
cryptography that uses a 56-bit key. DES is based on an IBM algorithm that was 
further developed by the U.S. National Security Agency. It is a block cipher, which 
breaks text into 64-bit blocks before encrypting it. There are several DES encryption 
modes.
DES encryption and decryption are very fast and widely used. The secret key may be 
used repeatedly, or it can be randomly generated for each session, in which case the 
new key is transmitted to the recipient using a public key cryptography method such 
as RSA. For more information, see the standard at 
http://csrc.nist.gov/publications/fips/fips46-3/fips46-3.pdf.

Digital Signature Algorithm (DSA)
The algorithm used in the Digital Signature Standard (DSS) created by the U.S. 
government. For more information, see the standard designation FIPS 
186-2+ChangeNotice at 
http://csrc.nist.gov/publications/fips/fips186-2/fips186-2-change1.pdf.

Directory
LDAP-based directories are databases that can be used to search for and retrieve 
attribute-value pairs. Directories can be configured to use (or support) authentication 
and access control protection. The schema of a directory describes the objects in the 
directory. The Secure Directory schema defines objects that support PKI.

Distinguished Encoding Rules (DER)
An ASN.1 encoding standard used for signature calculation for end-entity certificates 
and revocation lists (that is, CRLs, delta CRLs and ARLs). Also known as Binary.

Distinguished Name (DN)
The combination of attributes in a certificate forms the certificate DN. The following 
attributes are the most commonly used attributes:
• Common Name
• User ID
• E-mail Address 
• Organizational Unit
• Organization
• Locality
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• State or Province
• Country
• Domain Component
To avoid potential problems, all CAs in the PKI, including trusted CAs, should have a 
unique DN.

Elliptic Curve Cryptography (ECC)
A form of public key cryptography based on elliptic curve mathematics. ECC keys 
can be smaller than other keys while still providing the same degree of protection. 
Because of their smaller size, ECC computations tend to take less time and resources. 
These factors make ECC an attractive choice for systems such as embedded devices or 
smart cards, where resources such as RAM and CPU power can be severely 
constrained.

Elliptic Curve Digital Signature Algorithm (ECDSA)
The Digital Signature Algorithm (DSA) standard implemented using elliptic curve 
cryptography (ECC).

Elliptic Curves A and B
Elliptic curves A and B are the types of ECC curves that are supported in 
RSA Certificate Manager. For further information, see the IEEE standard P1363, 
“Standard Specifications for Public Key Cryptography.”

End-Entity Certificate
A certificate issued to an entity that cannot itself issue certificates (that is, the entity is 
not a CA). Because the entity that requests such a certificate is sometimes referred to 
as the client, end-entity certificates are sometimes called client certificates.

End User (or End-Entity)
An individual, group, or organization that either requests or holds an end-entity 
certificate. An end user can also be an individual who requests an end-entity 
certificate for a hardware device (such as a router), a server, a software application, or 
a piece of code. An end user that requests a certificate is sometimes called a requestor. 
An end user that is issued a certificate is sometimes called a certificate owner, 
certificate subject, or end-entity. An end user that relies upon someone else’s 
certificate to verify that person’s identity is sometimes called an end user, certificate 
user, or relying party.

Enrollment Server
A virtual web server host that is a component of the RSA Certificate Manager or 
Registration Manager Web Server. The Enrollment Server offers a 
server-authenticated site where public users (clients) can make certificate requests, 
retrieve issued certificates, and download CA certificates. The Enrollment Server has 
limited access to the Secure Directory Server.

Enterprise
An organization that uses computers and applications. In general use, this term is 
applied to businesses or organizations that operate on a large scale. Applications that 
are designed for these organizations are often referred to as enterprise applications.

Entity
A person, organization, or device (such as a router). In a PKI, an entity may be thought 
of as anything you can issue a certificate to.
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Extended Validation Certificate
A certificate issued to a web site so that its users can confirm the identity of the entity 
that controls the web site. EV certificates must meet the requirements in Guidelines 
for Extended Validation Certificates, established by the CA/Browser Forum. For more 
information, go to the CA/Browser Forum web site at 
http://www.cabforum.org/documents.html.

Extension
See X.509 v3 Certificate Extension.

FASC-N
FASC-N is the Federal Agency Smart Credential Number, which uniquely identifies 
each Personal Identity Verification (PIV) card. It is part of the Cardholder Unique 
Identification file (CHUID) and is the primary identification string used on all 
government issued credentials. For more information, see the standard at 
http://csrc.nist.gov/publications/fips/fips201-1/FIPS-201-1-chng1.pdf.

FIPS 140-1 Level 2 & 3
FIPS 140-2 Level 2 & 3

A standard developed by the National Institute of Standards and Technology (NIST) 
for implementation of cryptographic modules. Level 3 provides greater security than 
Level 2.

Firewall
A system designed to prevent unauthorized access to or from a private network.

Fully Qualified Domain Name (FQDN)
The full name of a system, consisting of its local hostname and its domain name. For 
example, “venera” is a hostname and “venera.isi.edu” is the FQDN. 

GOST
GOST (Gosudarstvenii Standart) refers to the Russian Government Standard for 
cryptographic protection for Data Protection Systems. Software products exported to 
Russia require the use of the GOST algorithm in order to be offered for sale. 
The GOST algorithm is supplied through the use of the Crypto-Pro Cryptographic 
Service Provider (CSP) v1.2.

Hardware Security Module (HSM)
The module that performs cryptographic functions and stores cryptographic keys in a 
secure fashion.

Hypertext Transfer Protocol (HTTP)
A set of rules for exchanging files (text, graphic images, sound, video, and other 
multimedia files) on the World Wide Web. 
Web browsers are HTTP clients that send requests to server machines. Users enter 
page requests by either typing a URL or clicking a hypertext link. The browser builds 
an HTTP request for the user and sends it to the Internet Protocol (IP) address 
indicated in the URL. The HTTP daemon in the destination server receives the request 
and, after any necessary processing, returns the requested page. See also HTTPS.

HTTPS
HTTP over an SSL/TLS connection.
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Identity Certificate
A certificate that links a public key value to a real-world entity such as a person, a 
computer, or a web server. Server certificates, CA certificates, and most end-entity 
certificates are all examples of identity certificates.

Issuing
The act of signing a certificate request with the private key of a CA to create a 
certificate.

Jurisdiction
A Jurisdiction is a set of configurations that define the form and content of the 
certificates issued under it, the life cycle management of those certificates, and the 
look and feel users will find when enrolling.

Key Pair
A public key and a private key associated with an entity that needs to authenticate its 
identity electronically or to sign or encrypt data. The public key is published, and the 
corresponding private key is kept secret. You can only decrypt data encrypted with the 
public key with the private key.

Key Recovery
The process of recovering a private decryption key from a secure archive for the 
purposes of recovering data that has been encrypted with the corresponding 
encryption key.

Key Recovery Operator (KRO)
An entity involved in the recovery of private keys through the use of tokens or smart 
cards. A configurable minimum number of KROs are required to access the hardware 
security module (HSM) individually within a specific time period.

Key Size
The size (in bits) of the key pair. A larger key size provides greater security. 
RSA Certificate Manager and RSA Registration Manager supports 1024, 2048, and 
4096 bit keys.

LDAP Directory
An LDAP-based directory is a database. You can search for and retrieve 
attribute-value pairs. You can configure directories to use (or support) authentication 
and access control protection. The schema of a directory describes the objects in the 
directory.

LDAPS
LDAP over SSL/TLS Connection.

Lightweight Directory Access Protocol (LDAP)
The standard Internet protocol for accessing directory servers over a network. LDAP 
is a “lightweight” (smaller amount of overhead) version of Directory Access Protocol 
(DAP), which is part of X.500, a standard for directory services in a network. There 
are two currently supported versions, LDAP versions 2.0 and 3.0. See also LDAPS.

Load Balancer
A software or hardware product that routes incoming data to one of a number of 
possible resources or applications.
Glossary 125



RSA Registration Manager 6.9 Vettor’s Guide
Logging Server
The Logging Server records PKI events for one or more client applications such as the 
Secure Directory Server. Event data is stored in a signed log file that can be verified 
and exported in XML or comma-separated value format.

Message Digest 5 (MD5)
An algorithm for creating a cryptographic hash (or “fingerprint”) of a message or data. 
MD5 can also refer to the value resulting from the application of the MD5 algorithm. 
A certificate MD5 value is unique to that certificate, and is often used to identify a 
certificate when setting LDAP and web server ACL rules.

MofN
A process of key encryption where a private key is split into N shares to be stored on a 
hardware device such as a token. M can be any value between 1 and to N. M shares 
are required to reconstitute the private key.

Nickname
A user-friendly character string that uniquely identifies a CA or CRL signer.

Non-repudiation
A concept that prevents the author of a message from denying having created that 
message at a later date (that is, repudiation cannot occur). Digital signatures help 
ensure the non-repudiation of transactions.

OCSP
See Online Certificate Status Protocol.

OCSP Client
The entity that issues a certificate status request to an OCSP responder. The OCSP 
client suspends acceptance of the certificate until the responder returns the certificate 
status.

OCSP Request
A client issues an OCSP request to obtain the status of a certificate. The client 
suspends acceptance of the certificate until it receives an OCSP response.

OCSP Responder
The OCSP Responder accepts certificate status requests from OCSP-enabled clients, 
looks up a certificate status in a CA database, and responds with the current certificate 
status.

OCSP Response
Once an OCSP response is received by the client who issued the OCSP request, the 
certificate is accepted by the client.

Online Certificate Status Protocol (OCSP)
A protocol, defined in RFC 2560, that enables applications to check the status of a 
certificate every time the certificate is used. If you configure your PKI to use OCSP, 
CRLs are unnecessary for end users.

Online Validation
Online validation occurs when a CA can be queried directly about the validity of a 
certificate every time the certificate is used. 
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Operator Card Set (OCS)
A card set within the nCipher security world that is used to generate, protect, and 
access the private keys created within it.

Persistent
If an OCS is made persistent, the keys protected by a member card remain in the HSM 
after the card has been removed from the card reader. By default, an OCS is 
non-persistent. An OCS can be made persistent or non-persistent at creation only.

PIV NACI
PIV NACI is Personal Identity Verification National Agency Check with Written 
Inquiries. Identity credentials issued to individuals without a completed NACI can be 
electronically distinguishable from identity credentials issued to individuals who have 
a completed investigation, based on the PIV NACI indicator extension.

PKCS #7
The Cryptographic Message Syntax Standard. For more information on the standard, 
go to www.rsa.com/rsalabs/pkcs/pkcs-7/.

PKCS #9
The Selected Attribute Types Standard. For more information on the standard, go to 
www.rsa.com/rsalabs/pkcs/pkcs-9/.

PKCS #10
The Certification Request Syntax Standard. For more information on the standard, go 
to www.rsa.com/rsalabs/pkcs/pkcs-10/.

PKCS #11
The Cryptographic Token Interface Standard. For more information on the standard, 
go to www.rsa.com/rsalabs/pkcs/pkcs-11/.

PKCS #12
The Personal Information Exchange Syntax Standard. For more information on the 
standard, go to www.rsa.com/rsalabs/pkcs/pkcs-12/.

PKIX
The evolving Internet Engineering Task Force (IETF) standard for PKI using X.509 
certificates. For more information on the standard, go to 
www.ietf.org/html.charters/pkix-charter.html/.

Privacy Enhanced Mail (PEM) format
PEM was originally created to provide secure e-mail services on the Internet, but it 
became too unwieldy for widespread use. Now, “PEM format” usually refers to the 
Base64 encoding algorithm that was part of the PEM proposal.
PEM encoding is useful for presenting binary data in a text-readable form. (For 
example, to allow you to copy and paste data between applications.) Also known as 
Base64.

Private Key
The private part of a public-key key pair. With RSA Certificate Manager and 
RSA Registration Manager, private keys are generated on the client whenever a 
certificate request is madePrivate keys must be securely stored to prevent 
unauthorized access and accidental deletion.
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A digital signature involves encrypting a message digest with a private key and allows 
anyone with the corresponding public key to decrypt the message digest to be certain 
of who sent the message and that it has not been tampered with.
You can decrypt information encrypted with a public key with the corresponding 
private key.

Public Key
The public and widely distributed part of a public-key key pair. For example, a 
certificate contains information about the certificate subject, the certificate signer, and 
a public key value. In general, you can only decrypt information encrypted with a 
public key with the corresponding private key.

Public-Key Cryptography Standards (PKCS)
A set of standard protocols developed by RSA for making secure information 
exchange possible. The standards include RSA encryption, password-based 
encryption, and cryptographic message syntax. For more information on the standard, 
go to www.rsa.com/rsalabs/pkcs/.

Public Key Infrastructure (PKI)
A system for publishing, distributing, and managing the public key values used in 
public key cryptography. All PKIs involve issuing public key certificates to 
individuals, organizations, and other entities and verifying that these certificates are 
valid.

Qualified Certificate
An end-entity certificate whose primary purpose is to identify a person with a high 
level of assurance in public non-repudiation services. For more information on the 
standard, go to www.ietf.org/rfc/rfc3739.txt?number=3739.
For more information on the European Telecommunications Standards Institute 
(ETSI) Technical Specification (TS) for the use of Qualified Certificates, No. 101 862 
v1.2.1, go to www.etsi.org/.

Registration Authority (RA)
An entity that performs registration services on behalf of a CA. RAs work with a 
particular CA to vet requests for certificates that will then be issued by the CA.

Revocation
Revoking a certificate invalidates it and removes all of its privileges in the PKI. 
Revocation is necessary if the CA administrator wants to invalidate the certificate 
before it expires. Administrators revoke certificates by marking them as invalid in the 
Secure Directory. Users of the PKI are notified of the revoked status a certificate 
during online validation or with revocation lists.
Revoking a CA invalidates the CA certificate and removes all the PKI privileges of 
the CA. Revoke a CA only if you have organizational-based security concerns and 
only as a last resort.

Revocation List Signer
An entity that signs complete CRLs, delta CRLs, and ARLs for a specific CA. An 
Administrator can designate a particular entity or the CA itself. 

Rivest-Shamir-Adleman (RSA)
A highly secure cryptography method created by the three founders of RSA: 
Professors Ronald L. Rivest, Adi Shamir, and Leonard M. Adleman.
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RSA uses a two-part key. The private key is kept by the owner; the public key is 
published. Data that is encrypted using the recipient’s public key can only be 
decrypted by the recipient’s private key, and vice-versa.
The RSA algorithm is computation intensive. Therefore, it is often used to create a 
digital envelope, which holds an RSA-encrypted symmetric key (often DES) and 
symmetric key-encrypted data. This method encrypts the secret symmetric key so that 
it can be transmitted over the network, but encrypts and decrypts the actual message 
using the much faster symmetric key algorithm.
The RSA algorithm is also used for authentication using digital signatures. In this 
case, the sender’s private key is used for signing, and the sender’s public key is used 
for verification. The RSA algorithm is also implemented in hardware. As RSA chips 
get faster, RSA encoding and decoding will add less overhead to the operation.

Root Bind
Clients normally identify themselves when binding (connecting) to an LDAP server 
(anonymous connections are also possible). Access control rules allow access to be 
granted to the directory information tree on the basis of the client's identity. A client 
may connect with root privileges if it identifies itself as the root user and has the 
necessary credentials to authenticate itself as such.
Clients binding as root are not subject to the normal access control rules and may read 
or write to any part of the directory information tree.
To bind as root, a client must know the name of the root user. In addition, it must have 
the corresponding password, or a specific X.509 client certificate from which the root 
name can be derived. 

root CA
A CA whose certificate is self-signed (that is, the issuer and the subject are the same). 
A root CA is at the top of a hierarchy.

SCEP Server
A virtual web server host that implements the Simple Certificate Enrollment Protocol, 
and provides a means for clients (primarily IPSec hardware and software agents) to 
obtain CA certificates and revocation lists, and to enroll for end-entity certificates. 
The SCEP Server is used by RSA Certificate Manager both as an enrollment 
mechanism and as a repository for end-entity certificates to be retrieved by routers and 
standalone devices with little non-volatile memory. It is not SSL-enabled. Security 
and authentication are enforced through the use of signed and encrypted PKCS #7 
messages. The SCEP Server has limited access to the Secure Directory Server.

Schema
A schema describes an object and its attributes in LDAP directories such as the 
RSA Certificate Manager or RSA Registration Manager Secure Directory.

Secure Directory Server
A secure LDAP directory that stores all of the information for your PKI. The Secure 
Directory publishes certificates and is used as a read-only repository for public users.

Secure Hash Algorithm (SHA-1)
An algorithm developed by the U.S. National Institute of Standards & Technology 
(NIST). SHA-1 is used to create a cryptographic hash (or “fingerprint”) of a message 
or data. SHA-1 is considered to be somewhat stronger than MD5. SHA-1 is defined in 
FIPS Publication 180-2, the Secure Hash Standard (SHS).
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Secure Hash Algorithm (SHA-256)
An algorithm developed by the U.S. National Security Agency (NSA). SHA-256 
operates in the same manner as MD5 and SHA-1 and creates a 256-bit cryptographic 
hash of a message or data. SHA-256 is considered to be stronger than SHA-1.

Secure Hash Algorithm (SHA-384)
An algorithm developed by the U.S. National Security Agency (NSA). SHA-384 is a 
variant of SHA-512 and creates a 384-bit cryptographic hash of a message or data. 
SHA-384 is considered to be stronger than SHA-1.

Secure Hash Algorithm (SHA-512)
An algorithm developed by the U.S. National Security Agency (NSA). SHA-512 is a 
variant of SHA-256 and creates a 512-bit cryptographic hash of a message or data. 
SHA-512 is considered to be much stronger than SHA-1.

Secure Sockets Layer (SSL)
A protocol layer created by Netscape to manage the security of message transmissions 
in a network. Security is achieved through encryption. “Sockets” refers to the sockets 
method of passing data back and forth between client and server programs in a 
network or between program layers in the same computer.

Secured Electronic Information in Society (SEIS)
The name of a non-profit organization in Sweden, working on implementing a 
common and open infrastructure to make communications in an open network, such as 
the Internet, secure. SEIS, founded in 1995, has developed a concept and the strategy 
to implement IT security for commercial use on a worldwide scale.

Security World
A security world consists of at least one hardware module, a set of smart cards, and 
encrypted data stored on a computer.

Server Certificate
An end-entity certificate issued to a server. Servers present their certificates to web 
browsers so browsers can verify (authenticate) the identity of the server. Server 
certificates are sometimes called SSL or TLS certificates.

Signing
A process by which a digital signature is affixed to a file, document, or certificate as 
proof that it has not been tampered with and that the author is who claims to be the 
author.

Simple Certificate Enrollment Protocol (SCEP)
A PKI communication protocol that supports the secure issuance of certificates to 
routers and other standalone devices in a scalable manner by using PKCS #7 and 
PKCS #10. 

S/MIME
Microsoft and Netscape include S/MIME in the latest versions of their e-mail clients. 
Other vendors of message products also endorse S/MIME.
MIME itself, described in the IETF standard RFC 1521, defines the structure of an 
electronic message. S/MIME allows the message body to include encryption 
information and a digital certificate. S/MIME has extended the syntax provided in 
PKCS #7. For more information on the standard, go to 
www.ietf.org/html.charters/smime-charter.html.
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SSL Client Authentication
The process whereby a server authenticates a client by verifying the end-entity 
certificate presented by the client during SSL operations.

SSL-LDAP
See LDAPS.

SSL Server Authentication
The process whereby a client application authenticates a server by verifying the 
certificate chain presented by the server during SSL operations, starting with a CA 
trusted by the client.

Status
The validity of a certificate: active, reinstated, revoked, or suspended.

Suspension
The process of marking a certificate as temporarily invalid. The end user presenting 
the suspended certificate is denied access where the certificate previously allowed 
access. Reinstating a certificate returns all removed PKI privileges.
Suspending a CA certificate marks it as temporarily invalid and removes all PKI 
privileges of the CA. Reinstating a CA certificate returns all removed PKI privileges.

System CA
The CA created during installation of RSA Certificate Manager to issue the server 
certificates for the System Web Servers and the certificates for accessing back-end 
functionality, either through the Web Servers, the Logging Server, or RSA Certificate 
Manager API applications. The System CA also signs the Administrative CA 
certificate. The System CA should not be used after installation except to re-sign the 
certificates it issued during installation.

System Log
An operating system-specific file that RSA Certificate Manager or RSA Registration 
Manager uses to record systemic events not related to regular operations or 
configuration changes.

Trace Log
A file containing information suitable for debugging purposes.

Transport Layer Security (TLS)
Internet protocol that provides privacy between server and client. TLS ensures that no 
third party may eavesdrop or tamper with any message. TLS is the successor to SSL; 
however, they are not interoperable.

UTF-8 Encoding
An ASCII compatible multibyte Unicode and UCS encoding, used by current 
browsers, Java and Plan 9.

Validation
The process of verifying that a certificate is valid. Validation can occur online or 
through the use of revocation lists.

Vetting
The process of reviewing a certificate request, verifying the information provided in it, 
and determining if a certificate should be issued. RAs may be used to vet certificates 
for CAs in large PKIs.
Glossary 131



RSA Registration Manager 6.9 Vettor’s Guide
Vettor
A person with an end-entity certificate who has vetting access to one or more 
Jurisdictions of one or more CAs through the Certificate Operations Workbench. 
Vettors are the trusted individuals within an organization that review requests for 
end-entity certificates. Vettors determine whether the RSA Certificate Manager or 
RSA Registration Manager should issue a certificate. Vettors also manage the status of 
certificates after they are issued.
The Certificate Manager Vettor certificate is signed by the Administrative CA; the 
Registration Manager Vettor certificate is signed by the CA of the Registration 
Manager initial target Jurisdiction.

Web of Trust
In an unstructured PKI, if enough CAs issue certificates that bind a particular name to 
a particular key, then another CA can accept that binding based on the trust that exists 
between the other CAs.

Web Server
An Apache-based server that is the primary interface to RSA Certificate Manager and 
RSA Registration Manager.

X.509
An International Standards Organization (ISO) standard that describes a basic 
electronic format for digital certificates.

X.509 v3 Certificate Extension
Certificate extensions, including extensions for PKIX, SET, and SSL. The 
RSAValidation Solution supports X.509 v3 that conform to version 3 of the X.509 
standard and specify additional constraints or capabilities on the certificate subject.

X-Parse
A template-based HTML extension language. It is used to compose web-based 
PKI-enabled applications.

XUDA Template
A XUDA template is a scripted HTML file. Each template combines regular HTML 
with scripting tags from the RSA X-Parse server-side scripting language, in much the 
same way that Java Server Pages combine regular HTML with JSP scripting tags. The 
X-Parse tags embedded in the HTML are parsed by the RSA Certificate Manager and 
RSA Registration Manager Web Servers, and the fully formed HTML result is 
returned to the browser.

Xudad
See Secure Directory Server.
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Acronyms

ACL access control list

AES Advanced Encryption Standard

API application programming interface

ARL authority revocation list

ASN.1 Abstract Syntax Notation One

CA certificate authority

CGI common gateway interface

CMP certificate management protocol

CP certificate policy

CPS certification practice statement

CRL certificate revocation list

CRMF certificate request message format

CRS certificate request syntax

CSR certificate signing request

DER Distinguished Encoding Rules

DES Data Encryption Standard

DH Diffie-Hellman

DIB directory information base

DSA Digital Signature Algorithm

ECC elliptic curve cryptography

ECDSA Elliptic Curve Digital Signature Algorithm

ETSI European Telecommunications Standards Institute

EV Extended Validation

FQDN fully qualified domain name

GAL Global Address List

GLB greatest lower bound
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GOST Gosudarstvenii Standart (Russian Equivalent of ANSI)

GUI graphical user interface

HSM hardware security module

HTML Hypertext Markup Language

HTTP Hypertext Transfer Protocol

HTTPS Hypertext Transfer Protocol (over an SSL connection)

IDS interoperability datasheet

I18N Internationalization

IEEE Institute of Electrical and Electronics Engineers

IETF Internet Engineering Task Force

IME Input Method Editors

IPSec IP Security Protocol

ISO International Standards Organization

ITU/CCITT International Telecommunication Union

KRO Key Recovery Operator

LDAP Lightweight Directory Access Protocol

MD5 Message Digest 5

MSIE Microsoft Internet Explorer

NES Netscape Enterprise Server

OCS Operator Card Set

PCI Peripheral Component Interconnect

PEM Privacy Enhanced Mail format

PIN personal identification number

PKCS Public-Key Cryptography Standards

PKI public key infrastructure

PKIX Public Key Infrastructure (X.509)

POP proof of possession

RA registration authority

RAM random access memory
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RSA Rivest-Shamir-Adleman

RSA-PSS RSA - Probabilistic Signature Scheme

S/MIME Secure Multi-Purpose Internet Mail Extensions

SCEP Simple Certificate Enrollment Protocol

SDK software development kit

SEIS Secured Electronic Information in Society

SHA-1

SHA-256

SHA-384

SHA-512

Secure Hash Algorithms

SPKAC Signed Public Key and Challenge

SSL Secure Sockets Layer

SSL-LDAP Lightweight Directory Access Protocol over a Secure Sockets 
Layer connection

UCS Universal Character Set (the superset of all other character sets)

URI Uniform Resource Identifier

URL Uniform Resource Locator

UTF-8 Universal Transformation Format

VPN virtual private network

XML Extensible Markup Language
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certificate attributes, 70
Certificate Management Protocol 

(CMP), 61–63
key ID, 61
shared secret, 61–63

Certificate Operations workbench
available functions, 23

certificate profiles
in Registration Manager, 99–100

certificate requests
approving, 40
deferring, 45
deleting, 45
invalid signature, 45
refusing, 45
status, 38
viewing, 37

certificates
CA certificate

downloading, 74
saving to file, 78
viewing, 98

end-entity certificate
downloading, 46, 72–74
issuing, 40
obtaining, 68–78
reinstating, 53
reissuing, 56
requesting, 69–72
revoking, 54
suspending, 52
viewing, 50

reasons for revoking, 32
reports, 58–60
revocation reason codes, 55, 86
selecting, 83
signer certificate

downloading, 96
saving to file, 97
viewing, 98

Vettor certificate
downloading, 31
obtaining, 29–32
request URL, 29
requesting, 30
revoking, 32

your certificate
downloading again, 89–90
exporting, 84
reasons for revoking, 84
reissuing, 88
renewing, 87–88
revoking, 84
viewing, 83

Certification Practice Statement (CPS)
standards, 79
storing passwords, 79

CMP. See Certificate Management Protocol
CPS. See Certification Practice Statement

D
default certificate profiles, 99
deferring certificate requests, 45
deleting certificate requests, 45
downloading

another’s certificate, 94
CA certificate, 74
end-entity certificate, 46, 72–74
revocation list, 95
revocation list signer certificate, 96
Vettor certificate, 31
your certificate again, 89–90
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E
end user

certificate
downloading, 72–74
downloading again, 89–90
exporting, 84
obtaining, 68–78
reasons for revoking, 84
reissuing, 88
renewing, 87–88
request refused, 72
requesting, 69–72
revoking, 84
viewing, 83

downloading CA certificate, 74
revocation reason codes, 86
role, 17–18

Enrollment Server
downloading CA certificate, 74
downloading revocation list, 95
downloading revocation list signer 

certificate, 96
interface layout, 26
renewing your certificate, 87–88
revoking your certificate, 84
saving CA certificate, 78
saving revocation list signer 

certificate, 97
viewing signer certificate, 98

extensions
authority information access, 102
authority key identifier, 103
basic constraints, 103
certificate policies, 103
certificate template name, 104
CRL distribution points, 105
extended key usage, 105
freshest CRL, 106
issuer alternative names, 106
key usage, 106
name constraints, 107
Netscape base URL, 107
Netscape CA policy URL, 107
Netscape CA revocation URL, 107
Netscape certificate renewal URL, 108
Netscape certificate type, 108
Netscape comment, 108
Netscape revocation URL, 108
Netscape SSL server name, 109
Novell reliance limits, 109

PIV NACI, 110
PKIX OCSP no check, 110
policy constraints, 110
policy mappings, 111
private key usage period, 111
Qualified Certificate Statements, 111
SEIS cardnumber, 114
SET card certificate required, 114
SET certificate type, 114
SET extensions, 115
SET merchant data, 115
SET tunneling, 116
subject alternative names, 116
subject directory attributes, 117
subject key identifier, 117

H
how to get help, 23

I
international characters, entering and 

displaying, 20
issuing certificates, 40

J
Jurisdiction, definition, 13

O
online help, 23

P
passwords

choosing, 79
protecting, 79
storing, 80
strong, 80
transmitting, 80

profiles. See certificate profiles
protecting private key

end user, 79–81
Vettor, 33

R
refusing certificate requests, 45
reinstating certificates, 53
reissuing certificates, 56
reissuing your certificate, 88
renewing your certificate, 87–88
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reports
certificates, 58–60
user counts, 58–60

revoking certificates, 54
revoking your certificate, 84

reasons for, 84

S
search filters, 25–26
shared secret

creating, 62
managing, 63
searching, 62

suspending certificates, 52

T
two-factor authentication, 80

U
user counts, 58–60

V
vetting certificates

procedures, 37–47
related tasks, 49–57

Vettor
certificate

downloading, 31
obtaining, 29–32
request refused, 31
request URL, 29
requesting, 30
revoking, 32

protecting private key, 33
role, 15–16
tasks, 37–57

viewing
another’s certificate, 94
certificate requests, 37
certificates, 50
signer certificates, 98
your certificate, 83

W
Windows

Input Method Editors, 20

X
X.509 v3 certificate extensions

See extensions
See also certificate profiles
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